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Artologik® ProjectManager
The Artologik products simplify a number of administrative tasks.
Artologik ProjectManager is a project management system which
facilitates the control and realization of projects. 

The built-in time reports automatizes the collection of data which is usually
very time consuming both for the Project Leader and the Administrator. In a
simple way, each user registers his/her working hours directly into the
program. This can be done once or several times a day. Time and other
expenses are registered according to project, phase and activity and are
available immediately for time and project reports in the project management.
Besides saving a lot of time and work, it facilitates the planning of projects and
resources that are up-dated and based on reality. 

Since the program is web-based it gives all the users access to the time
registration and project management from any location and makes it possible
for the project members to collaborate, whatever the time or location.

A Simple and Flexible System
ProjectManager is a simple and flexible system and you can decide what parts
your project should include. You can either use ready-made project structures
or create your own unique structure in a simple manner. The web technology
allows you to minimize the administrative work by using the same data for
different purposes. In most cases, the information you need only have to be
entered once. Using the program's functions for resource planning, the project
leader can get a quick survey of the resources available at a certain time.
Through various reports, the program offers easy access to the information
you want.

Artologik ProjectManager will help you to:
• Keep the projects on the right track and ensure that aims and guidelines

are followed.
• Create time frames for the project phases and activities and perform

regular follow-ups.
• Facilitate the work of producing and calculating offers.
• Receive current figures on the resource utilization during a certain period.
• Facilitate the production of cost estimates.
• Provide the project leader with a quick survey of projects in progress.
• Collect documents about the project and make them available for the

Project Members.
• Facilitate project follow-ups through time reports.
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Artisan Global Software has intellectual property rights relating to technology embodied in the product that is
described in this document. This document and the product to which it pertains are distributed under licenses
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Artologik ProjectManager

User Roles
There are three different user roles within the system: Project member, Project
leader and Administrator. The task of being the administrator is suitable for
those registering users and for those working in the finance and accounting
department. The project leader role is suitable for those working actively with
creating new projects and administrate these. The project member role is for
the rest of the users. For each role, the administrator sets different standard
access rights e g the rights to administrate customer directory and verify
registrations. These standard access rights are then used as default when
creating a new user with the specific role. The access rights can also be
modified for each individual user. 

The manual consists of the following parts:

• Projects
• Project administration
• Time registration, verification
• Reports
• Administration

If you in the applications can not see all parts, it is probably because you
don't have the access rights, or that your organization has chosen not to use
that specific feature.

At the end of this manual you will find a section called Getting started. This is
a step-by-step description of how the administrator enters the information
required to start using ProjectManager.

Definitions
A project consists of three components: Basic data, Project phases and
Activities.

Basic Data
The basic data includes basic information on the project such as: Project
name, Persons involved, Customer, and planned Start and End dates of the
project etc.

Project Type, Phases and Activities
The project type indicates what type a certain project belongs to. The project
type includes several different phases, which are then divided into activities.
The various components of a project type can be defined in the system to
make the setting up of new projects easy. The example below is based on
the project flow of an internet company for a certain type of project. However,
the predefined phases are easily modified. When you have selected a project
type, the program displays a number of project phases. Some examples are:

© Artisan Global Software 
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• Marketing
• Concept
• Alpha version
• Beta version
• Delivery
• System documentation
• Follow-up

Each project phase is then divided into modules, which we hereafter refer to
as activities. An example: the project phase Marketing could include the item
Customer meeting as an activity.

Default Values
To facilitate the use of the system, the administrator can pre-define the
phases, activities and standard descriptions that are available when a new
project is set up. In this way, you can use the same project structure for
several projects of a similar nature, i e you do not have to enter the
information every time. 

Icons
Regardless of the role you use to log in to ProjectManager, you see a number
of icons at the bottom of the page. These icons facilitate your work since they
are short cuts to different functions.

If you move the mouse pointer over the icon, you will see what it stands for.  

Registration
When you click on the icon Registration you come directly to
ProjectManager's time registration section. In order to get back to the project
section, you click on the same icon again, which is now called
ProjectManager.

• In the Registration section you register the time you have worked on
different projects in a quick and easy manner.

• Verifications of registered time and products/services are also made
in the Registration section.

• A weekly plan can be made.
• Reports for the registered time can be produced. 

TimeKeeper
The timekeeper will help you see how much time you spend on different
projects, phases and activities. Many registrations can be opened
simultaneously, but only one can be clocked at the time.

1. Click on the Timekeeper icon.

2. If no default registration has been chosen or if there are no default
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registrations, click on the button New registration. 

3. Fill in the data about the Customer, Project, Activity, Phase and
Time code. Also include a more detailed Description of the
registration under comment.

4. Click on the Clock icon to start the timekeeper. 

5. To stop the timekeeper, click on the Clock again.

6. To save the time registration data, click on the Disk icon to save.

7. In the text field, you can also register the exact amount of minutes
you have worked on a project. Make sure to save the data.

If you have selected to display several time registrations in the timekeeper
window, you click on the registration you want to report to. You cannot have
several time registrations ticking simultaneously. If you start another one, the
first time registration stops. If you want to cancel a time registration you
started, just delete the data in the text field and choose Close (the icon
marked with an X).

When you have finished your work and want to register your time, just click
the Save button.

Note! If the smallest time span for registration is set on e g 20 minutes and
you want to save a registration of 10 minutes, 20 minutes will be registered
when you click Save. You do not have to save the time data every time you
stop the clock, even if you change projects occasionally. When you want to
continue working on the first project, you can easily start the timekeeper
again. 

Should the web browser crash or close down by mistake, the timekeeper
would continue from when the web browser was closed, since the
information is saved on the local machine as a cookie.

If you want to minimize a time registration you click the Minus sign, to
expand, click the Plus sign.

Weekly Plan
In a simple manner, the weekly plan makes it possible to see planned
projects for the current and for the following week. The planning can be made
either in the window that opens when you click the icon Weekly plan, or in the
registration section of the program. Click the icon Registration to get there.
Then go to the menu Weekly plan.

You can edit your planning by clicking the button Edit for the week in
question. Each day's planned projects are then replaced by a selection list,
where you can mark the projects you want to work with during that day or
week.

If you want to choose several projects in one day, press Ctrl while clicking the
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options in the list. Save and close when you are finished.

You can only edit your own weekly plan, but you can look at other users'
plans by selecting their names in the selection list. 

User
When you click the icon User, a window pops up, showing your user
information (of the user you logged in as). Changes can be made. Make sure
to save the information.

Calculator
When you click the icon Calculator, a window with a calculator pops up. If
you quickly want to calculate a price or expense, or sum up a registration,
this is a useful function. 

My Planned Time
This icon opens up a window with your personal organizer. Here, you get a
quick survey of what you are scheduled to do, month for month. You can see
how many hours are planned for each project, phase and activity and during
what period the work has to be done. Additionally, you can see your resource
graph.

If desired, you can also print the schedule by clicking the Print icon.

The project leader or the administrator plans the schedule. This is done in the
menu Project administration, Plan time.

© Artisan Global Software 
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Projects
In the part Projects, basic information is displayed on a project: Customer,
Project leader, Project members, Project type, as well as the total of the
Planned and Registered time for the different phases.

Below each phase and activity, the project leader can see the status of the
phase or activity, and how much time has been planned and registered. By
each activity, the project leader registers the time and product/service
utilization. You can also view who has done what for each activity by clicking
the linked activity name. If there are any documents connected to the project
in question, you would find them under the heading Documents.

Search for Projects
You search for projects in selection lists, either by customer or project name.
It is also possible to search by project number, ID or name. You can only
search for projects of which you are a member or project leader. The
administrator can view all projects. 

In the first selection list, you select the customer you want to view information
about. The project(s) of the selected customer can be found in a selection list.
By clicking the linked project name, you can view the basic information on the
project selected. The information displayed is the Project ID, Project name,
Project number, Project member(s), Project type, Start- and End dates, as
well as a short Description. Under the heading Phases, you can view the
status of the project's phases and the number of hours planned and
registered for the project.

The second selection list, Projects, includes projects of which you are a
member or project leader. 

You can also make a search using the project number, project ID or project
name.

Documents
When the project has started, any project member can study the information
material which the project leader has linked to the project and made available
to the members. This could be text, tables, images etc., which are used as a
basis for the planning, realization and follow-up of the project. 

You can also create your own folders and link your own documents to the
project.

Navigate and Read
1. Folders with a plus sign contain more folders, which will be

displayed if you click the sign. Click the plus sign next to the folder
until you get to the level you want.

2. The contents of the folder are displayed when you click the folder
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itself. When the folder is selected, the icon looks like an open folder. 

3. The large window to the right of the folder icons displays a list with
the documents in the folder selected. The documents are opened in
a new window when you click the document name.  

4. If you click the icon of the documents where you are listed as the
owner, a window opens to display information about the access
rights for this particular document. You can use this page to indicate
if project members and the project leader should be able to read or
edit the document. 

5. You can sort the documents in a folder in various ways by clicking
the headings Name, Size, Type, Edited and Owner. 

Create Folders
1. Select the folder where you want to create a new folder. Click the

button New folder.  

2. A pop-up window is displayed where you can name the folder and
specify access rights. 

3. Save and close. 

Delete Folders
You can only delete your own folders. 

1. Select the folder you want to delete. 

2. Click the Delete button. You will be asked to confirm that you want
to delete the folder. 

Add Document
1. Select the folder which you want to add the document to. 

2. Click the Browse button. 

3. Find the folder where your document is currently located and mark
it. Click Open. 

4. Click the Add button to copy the document into the folder. 

A variety of data about the document is displayed in the documents list when
the folder in question is selected. You can sort the documents in the folder
based on these data. Just click the heading of the particular data in the grey
bar. If you click it again, the sorting order is reversed. 

Document Information
The icon next to the document name is a link which opens a window
containing information on the properties of the document, such as name and
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accessibility for the project members. The read access right allows you to
view the document, but not edit it. The write access right allows you to view,
edit and delete the document. Specify what rights you want to use. Save and
close. 

After the document name you find information on size, file type, time when it
was last edited and owner, i e the person who added the document to the
folder.

Delete Document
If you have been given write access rights for the document, the system
displays a check box to the left of the document. To delete the document,
select this box and click Delete. 

Project Status
In order for the project member to be able to change the status of a phase or
activity, extended rights are needed.

When a project has been selected, you will be able to view basic project
information such as project number, project leader, status, members, the
person responsible, planned time and registered time. 

Click All Phases or select a specific phase in the right-hand menu. Either, you
will view all phases and activities of the selected project, or the specific phase
you have selected.

• Red cross = Inactive 
• Yellow circle = Active 
• Green tick = Concluded 

You can view the information registered for the phases and activities by
clicking the linked phase or activity name. In the text field displayed, you can
view the members of the phase and their registered time.

Register Time
Instead of using Registration/Verification, you can register worked time on
each activity using the Project menu. The time you register is automatically
transferred to Registration. 

It is not possible to view or register time for a project, phase or activity if you
are not a member of it. If the administrator has chosen that it should only be
possible to register time for active phases and activities of a project, only
these will be available for registration.

1. In the right-hand menu, click All phases, or select the phase you
want to register time for. 

2. You will see a clock icon on each row of a phase/activity for which
you are registered as a member.
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3. Click the Clock icon to display a pop-up window. 

4. Today’s date is set automatically. You can select another date using
the selection lists. 

5. Register the time worked.

6. Enter a comment. 

7. Click Save if you want to register several time periods, or Save and
close if you are only registering one period. 

8. Close the pop-up window when you are done with your
registrations. 

Register Products/Services Purchased
You can register products/services straight away for each activity. The
administrator and users with extended rights can register suppliers and
products/services which you are able to choose from when making your
registrations. If you are not included in an activity as a member, you are not
allowed to register products/services to it. 

1. Click the Shopping cart icon next to the clock. Make sure that the
right date is selected in the selection lists. If not, change it.

2. Select a customer and project in the selection list to the left. 

3. Select a phase and activity. 

4. Select a supplier in the selection list to the left. 

5. Select a product/service in the selection list to the right.

6. Write a comment

7. Specify the quantity and unit used for the product/service as well as
cost and price per unit. The total is summarized automatically. Click
Add.

8. Repeat steps 2–6, if you want to register another product/service.

9. If you want to edit the product/service registration, click Edit under
the heading Event for the product/service in question, and make
your changes. Save.

10. You can delete a product/service registration by clicking Delete.

11. You can copy a product/service registration by clicking Copy.

12. If you want to make a search for own product/service registrations
made earlier, you can find them by browsing the selection lists for
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Own registrations.

13. If you click the Clock, you will be transferred to a page where you
can register time.

Viewing Time Registered for Activities
If you click the name of the activity under phase/activity, you will see the total
amount of time registered, and the user involved for the activity selected.

© Artisan Global Software 
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Project Administration
Only the administrator and the project leader can view this heading in the
menu. Here, you can create new projects and administrate the phases and
activities of your projects. Each project leader contributes to the file of
documents on planned projects.

In the project administration, the project leader enters all the information
displayed under the menu Projects: Project name, Customer, Project leader,
Project member(s), Project type and Start and End dates. You can also enter
a Description of the project, Offer and Order information and Cost and Price
information.

For each phase and activity, you can specify planned time and start and end
dates. The more detailed the information in the project administration part,
the better the reports. You can print reports to use within the project group or
externally, for presentations. 

Basic Information
The basic information is displayed when you have selected a project. Through
this information you can update the project name, the project ID, the project
group, the customer, add and delete the customer's contact persons, the
project status, the description language, the project leader, the supervising
director, the result unit and the start and end dates. You can also see a
description of the project, information on when negotiations were initiated and
concluded and an economic survey.  

If the administrator has chosen to use programmes, you can also
administrate and edit these here. Do this under Administration >
Organisational settings > Settings. For more detailed information, see
Administration > Programmes, in the manual.

Description and Comments
If you click the expand button next to description and comments, you can
read and modify the project description and comments.

The field Comments for reports, is displayed in the report Order information. 

Offer and Order Information
Below offer and order information, you enter information at the start of the
project, from recommendation to order verification. Next to each entry, there
is a text field where you can write a short description or refer to a document.
The description can be no longer than 50 characters.

Enter information on:

• Who recommended your company to the customer.
• When the inquiry was made.
• Who were the directors attending. Select persons by marking the
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names in the box to the left and, by clicking the right-hand arrow,
transfer the names to the text field to the right. If you want to
remove a selected name, you mark it in the text field to the right,
and click the left-hand arrow.

• When the offer was made. 
• When the order of the project was verified.

Cost and Price Information
Below the cost and price information, you can easily get a display of the
financial status of the project. You can see payments in advance, if any, and
calculate the cost and price of the project. You can also calculate different
cost and price models based on different factors, as well as what have been
invoiced up to that point.  

If a customer is paying in advance, you fill in this information, the amount, and
when the payment in advance was made. 

Below the cost model, you can view and calculate the cost of the project for
your company.

1. Select a cost model in the selection list.

2. Set a cost for the alternative selected, by clicking Set cost.

3. Click Calculate to calculate the cost of the project, based on the
selected model. In this way, you can easily see which model is the
most profitable for this project.

Below the price model, you can view and calculate the price of the project for
the customer.

1. Select a price model in the selection list.

2. Set a price for the alternative selected by clicking Set price.

3. Click Calculate to calculate the price of the project, based on the
selected model. In this way, you can easily see which model is the
most profitable for this project. Additionally, you can view
information on invoice details and invoices.

When you click View invoices, you can view information on invoices and
invoice details. You can see which are active as well as concluded, the dates,
number and amount. Consequently, you will be able to survey the amount of
money generated in the project, so far. 

To Create a New Project
This is where you enter data on the new project, such as basic information,
members and time plan. 

1. Select New project in the selection list under Project.
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2. Enter the project name and ID. 

3. Indicate if your new project is an Internal or External project. 

4. Select a customer in the selection list.

5. Select project status in the selection list. The project could be either
Inactive, Active, Concluded, Cancelled or Filed. In order to register
time, the project must be active. The inactive status indicator could
be convenient to use initially, e g in the offer stage.

6. Go to the Description language selection list and indicate the
language to be used for the project texts. This list includes all
languages registered to the system by the administrator. If you, for
instance, are going to write an offer for an English-speaking
customer, select English as the description language to produce the
background documents required for the offer in this language.

7. When creating a new project, you can only select yourself as the
project leader. If you are updating a project, you can select
somebody else as the project leader, but this means that you will no
longer have the right to edit the project structure, the time plan etc.
However, the administrator can select any of the registered users as
project leader.

8. Select a supervising director. A supervising director has the final
responsibility for the project. In order to be a supervising director,
you need to have the rights of an administrator. 

9. Specify the result unit that will be responsible for this project. The
result unit is the unit within your organization that enters the invoice
into the accounts. The program suggests that you use the result unit
which the project leader belongs to.

10. Specify the cost model to be used for the customer in this project:
fixed cost, cost per hour at project level, cost per hour at phase
level, cost per hour at activity level or cost per hour at user level.

11. Specify the price model to be used for the customer in this project:
fixed cost, cost per hour at project level, cost per hour at phase
level, cost per hour at activity level or cost per hour at user level.

12. Select project members by highlighting the names of the users that
are to be involved in the project in the User field. Click the right-hand
arrow to register users as project members. You can cancel your
selection by highlighting the name of the user in the User field and
clicking the left-hand arrow. To highlight more than one user you
hold down the Ctrl or Shift key while clicking the names. 

13. Select a project type. The various project types available have been
registered by the administrator. Generally, only a small number of
similar project structures are used over and over again for new
projects. By using ready-made structures, you do not have to create
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an entirely new structure each time you set up a new project. By
clicking the name of the project type you display a description of the
project type in a pop-up window.

14. Enter start and end dates of the project. All phases and activities are
given these start and end dates automatically. When you later begin
to administrate the phases and activities, you can change the dates
to the ones actually planned. 

15. Enter a project description of a maximum of 4 000 characters. This
description is included when you create an offer and is also
displayed in the basic information of the project. 

16. Click Save. You will now see the names of the pre-defined phases in
the right-hand menu. Click All phases to go to a new page, where
you can administrate the phases and activities that are pre-set for
the project type you have chosen for your project. A more detailed
description of this is provided further on in this manual. 

17. When you have selected Save, three new forms are shown under
the heading start and end dates. These are: Description and
comments, Offer and order information and Cost and price
information. By clicking the plus signs, you can expand the forms.
By clicking the minus sign, you minimize the forms. 

18. Below these forms there is an additional set of plus and minus
buttons. These expand or minimize all the forms on the page.  

19. There is also a Delete button and a Save button. By clicking Delete,
you delete the entire project and by clicking Save, you save the
latest changes.

Edit Information for an Existing Project
If you want to edit an existing project, you select one of the projects in the
selection list under projects. The right-hand menu now displays a range of
menu options with the names of the phases included in this project. By
clicking these options, you display information on each of these phases. You
can also update the information on the phases. Click the All phases option in
the right-hand menu to display information on all phases and activities. The
following headings are available: Phases/activities, Sorting order,
Responsible, Start date, End date, Planned time, Time registered and Delete.
The order of the activities within the phase can be modified as required. Click
save when you have made your changes. You can delete a phase or activity
by clicking delete. 

The name of the phase is a link to a window displaying the planned time for
the particular phase in question and its activities. You can edit the phase,
activity, description and the members.
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Copy a Project
1. Select Copy project in the projects selection list. 

2. Select the project you want to copy in the list displayed. Mark the
box by a tick if you want the planned time to be copied into the new
project or if you want the document folders to be copied or if you
want both document folders and files to be copied.

3. Click Copy. The page that is now displayed can be used to update
information on the project. 

4. Click Save when you have made your changes. 

Members
In the menu Members you can add or delete members in your project.

The box in front of each registered user can be marked by a tick or be left
unmarked. In this way you decide who should be a project member or not. 

In the phase and activities lists, select the phase and activity you want to
work with, or select all. The project leader can be changed.

For each project you can see the planned and registered time for each
member. 

Documents
When the project has started, any project member can study the information
material which the project leader has linked to the project and made available
for the members. This could be text, tables, images etc., which are used as a
basis for the planning, realization and follow-up of the project. 

You can also create your own folders and link your own documents to the
project.

Navigate and Read
1. Folders with a plus sign contain more folders which will be displayed

if you click the sign. Click the plus signs next to the folders until you
get to the level you want.

2. The contents of the folder are displayed when you click the folder
itself. When the folder is selected, the icon looks like an open folder.
 

3. The large window to the right of the folder icons displays a list with
the documents in the folder selected. The document is opened in a
new window when you click the document name.  

4. If you click the icon of the documents where you are listed as the
owner, a window opens to display information about the access
rights for this particular document. You can use this page to indicate
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if project members and the project leader should be able to read or
edit the document. 

5. You can sort the documents in a folder in various ways by clicking
the headings Name, Size, Type, Edited and Owner. 

Create Folders
1. Select the folder where you want to create a new folder. Click the

button New folder.  

2. A pop-up window is displayed, where you can name the folder and
specify access rights. 

3. Save and close. 

Delete Folders
You can only delete your own folders. 

1. Select the folder you want to delete. 

2. Click the Delete button. You will be asked to confirm that you want
to delete the folder. 

Add Document
1. Select the folder which you want to add the document to. 

2. Click the Browse button. 

3. Find the folder where your document is currently located and mark
it. Click Open. 

4. Click the Add button to copy the document into the folder. 

A variety of data about the document is displayed in the documents list when
the folder in question is selected. You can sort the documents in the folder
based on these data. Just click the heading of the particular data in the grey
bar. If you click it again, the sorting order is reversed. 

Document Information
The icon next to the document name is a link which opens a window
containing information on the properties of the document, such as name and
accessibility for the project members. The read access right allows you to
view the document, but not edit it. The write access right allows you to view,
edit and delete the document. Specify what rights you want to use, then save
and close. 

After the document name you find information on size, file type, time when it
was last edited and owner, i e the person who added the document to the
folder.
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Delete Document
If you have been given write access rights for the document, the system
displays a check box to the left of the document. To delete the document,
you select this box and click Delete. 

Plan Time With the Gantt Chart
Under Project administration > Time planning, you can view a Gantt chart.
This is a survey time chart that displays the planned time for phases and
activities on the basis of the time frames set for the overall project. The Gantt
chart can be edited and you can easily change the time of the phases, as well
as of the specific activities. The information on resource utilization in the Gantt
chart is gathered from the individual calendars which are managed by the
administrator and the users concerned. You find the calendar under
Administration > Calendar maintenance. Select a user in the list.

What Can You Do in the Gantt Chart?
• You can change the start and end dates of the

phase/activity/project member.
• You can change the number of hours planned for the

project/phase/activity/project member. However, start and end
dates of the entire project are changed using the Project
administration > Basic information menu option. 

• Additionally, you can see the resource utilization of your project
members in per cent. In this way, you can see if you have scheduled
them for more working hours than they are actually available for
during that period.

Changes can be made either by entering a new value in the column, or by
moving, extending or shortening the box that represents the
phase/activity/project member in the chart. 

1. Select a project and click Plan time in the right-hand menu. This will
display the Gantt chart of the project. You can use the selection
boxes at the top of the page to select another project that you want
to view or process. 

2. By clicking the button Settings you can make your own personal
choices, for instance, how values should be summarized in the
Gantt chart and what format should be used to display time. A more
detailed description of this can be found below.

3. If you want to view the Gantt chart in full screen format, you simply
click the button Full screen. When you want to display the menu
again, you click Save and close to close the full screen window. The
phases of the project are listed in the dark fields, activities in slightly
lighter fields and the members in the most light-colored fields. 

4. Using the radio buttons at the top of the page, you specify if you
want to display the Gantt chart based on day, week or month. 
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5. In the column Time, you plan the hours by entering the planned
amount of hours for the phase, activity or user in question. 

6. The start and end dates of the phase/activity/project member can
be adjusted in the columns Start and End. You can also move the
mouse across the colored fields of the Gantt chart, hold down the
left mouse button and drag the field in the direction you want. When
the mouse pointer is displayed as a symbol with two horizontal
arrows, you can extend or shorten the field. When the mouse
pointer is displayed with arrows in all four directions, you can move
the entire, highlighted field sideways, but the dimensions are not
changed.

7. In the column Resource utilization (%), the project member's
resource utilization is shown for the entire time period planned.
(When you change a field in the schedule, the change is not
registered until you move the mouse.) To help you get a survey of
the resource utilization, there is also a pop-up window that is run
through settings. When you move the mouse across the Gantt
chart, dates, names and resource utilization are shown, both for the
entire period planned (by the column %) and for each separate day.

8. Below the big planning chart, there is a smaller one that shows the
resource utilization for a certain user or group of users. You see the
working hours, the amount of available hours, the planned time and
the planned overtime as differently colored boxes.

This chart can be of help when you are to make a time plan, since you can
see the resource utilization. The time line follows the same settings as the
project chart. 

Settings
1. Click the button Settings if you have not already made the important

settings required for the proper working of the functions of the Gantt
chart. Your settings are personal, but if you save them they are used
for the Gantt charts of all your projects. If you do not save, these
settings are only used temporarily for the active Gantt chart.

2. Use the option Time format to indicate if you want to display hours
and minutes as decimal numbers, (two and a half hours = 2.5) or as
a number of hours and minutes (two and a half hours = 2:30). 

3. Changing the planned time lets you work in the Gantt chart using
two different methods:

Method 1: Based on the number of hours of the project members
(Add the difference to the upper levels).

Select this alternative if you want to start by planning the hours of
the project members. Specify for each person and activity the
working time required. The time is summarized upwards to the
phase level, as well as in total to the project level.
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Method 2: Based on the total project time (Distribute the difference
over the remaining project members).

Select this alternative if you want to start by setting the total time
budget for the various phases and activities in the Time column. The
hours are then proportionally distributed between the project
members in the active phase or activity. If a field in the column is
adjusted manually, it has a black mark, which means that the field is
locked. When other fields are changed, it cannot be proportionally
adjusted until the closest level above has been changed again. 

4. Under the heading Change of start and end dates, you mark Upper
levels are adjusted automatically, if you want the total start and end
dates of the project/phase/activity to follow the start and end dates
of the levels below. This means that the start and end dates for an
activity can never go beyond the time frames for the phase when
you adjust the planned time. 

Mark Lower levels are adjusted automatically, if you want changes
of the total time on project or activity level to be proportionally made
in the lower levels as well.   

5. Under the heading Additional aid, you indicate if you want to use the
small pop-up window, which displays today's date, the name of the
project member and his/her total resource utilization for the day
concerned when you move the mouse pointer across the Gantt
chart. The information displayed is: Number of available working
hours, Number of planned hours and Resource utilization as a
percentage. When the mouse pointer is placed in a field in the
column % (resource utilization), this information is displayed for the
entire period. 

This is also where you select the grid lines you want to display in your
Gantt chart. 

Below, you can find further information on add phase/activity.

Administration of Phases and Activities
Use the Project administration > All phases option to administrate the phases
and activities of the project. Select an existing project or create a new one.
On the page now displayed, you can view all the standard phases and
activities included in the project type selected for your project. You can either
use the standard structure, or create a structure that is unique by creating
your own phases and activities.

If you have selected an existing project, you will be able to view the phases
and activities registered for this particular project.

If you click Project description, a description of the project and a list of
phases and activities are shown, as well as their planned time and start and
end dates.

© Artisan Global Software 



Manual | 19

1. Click the name of the phase to view an information page of the
phase. This page can be edited and shows the phase, activity,
description, planned and registered time and a member list. In the
member list you can add or delete members and change who is
responsible for the phase/activity. To edit other phases or activities,
you select them in each separate selection list. Do not forget to
save.

2. Click Start or End date or Planned time to display a Gantt chart of
the phase. This chart can be used to indicate the planned time for
each activity. The sum total of the planned time for the activities
corresponds to the planned time for the phase in question. This
figure will change automatically if you alter the time for any of the
individual activities. For more information, look under the heading
What can you do in the Gantt chart?.

3. Specify the order of the activities and phases by entering figures in
the fields under the heading Sorting order. When you click Save, the
order is updated. 

4. If you want to use the ready-made structure of the phases and
activities for the project type you have selected, click Save. If you
want to add any further phases and activities, click the button Add
phase/activity, see the paragraph below. 

Adding New Phases and Activities
You can add new phases and activities that are not included in the project
type you have selected. In this way, you can create unique project structures,
adapted to the project in question.

1. Click the button Add phase/activity. 

2. Go to the selection list Phase and select New or an existing phase
where you want to add a new activity. If you select an existing
phase, go to step 4.

3. Enter the name of the phase. 

4. Enter a name of the activity. 

5. Mark the box New by a tick if you want the new activity to be added
to the project when you save. If the box is left unmarked, a new
activity is added to the phase, but is not linked to the project. When
saved, the activity can be marked and linked to the project.

6. Mark the box Unique for this project if you only want the new activity
to be part of that project.  

7. Click Add activity. Repeat steps 4-7 to add more new activities to
the phase.
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8. Save.

Adding Phases and Activities that Already Exist in
the System
The page where you add new phases and activities can also be used to add
phases that already exist in the system. This data was registered by the
administrator. 

1. Click the button Add phase/activity. 

2. Go to the Phase selection list and mark the phase you want to add.
Phases that are already included in your project are indicated by an
X.

3. Add one or more of the activities which are already included in the
phase, by selecting the check box next to the name or by entering
the name of an activity. Click Add activity.

4. Close the window if you are finished, or repeat steps 2-3 until you
have added all phases and activities preferred.  

Updating an Activity
On the same page as you add new phases and activities, you can also
update activities you have created yourself.

1. Click Add phase/activity. Then click the activity name which is linked
to the phase/activity. Only activities that you have created work as
links.

You can change languages of the name and description of the
activity (depending on what languages are used in the system). Note
that the name and description changes you make only affect the
activities you created. The activities which the administrator created
are NOT affected. 

2. Save and close. 

Updating a Phase
You can update existing phases on the page where you add new phases and
activities, i e you can add new activities and change the names of the phases
and activities. You can only update phases you have created yourself.

1. Click the button Add phase/activity. 

2. Select the phase you want to update from the selection list. 

3. Click the button Update phase. You will now display a page where
you can edit the name and description of the phase.

4. Update the name and description of the phase in all the languages
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registered in the system.

5. Save and close. 

Deleting a Phase or an Activity
You can only delete phases or activities for which no working time has been
registered. In order to delete a phase or an activity from a specific project,
you click the recycle bin to the right of the name. 
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Time Registration
It is easy to make time registrations for the projects for which you are
registered as a user. You select if you want to register the time directly for
each phase or activity in ProjectManager, or if you want to do it in the
Registration/Verification part by selecting the period you want to register for.
The data registered in the Registration part is automatically registered in
ProjectManager, and the information can be used for e g different reports.  

If users wish to register time which is not bound to any specific project, the
project leader can create a project for e g education, administration or internal
work. The members can then use this project to register their time.

Tip: The time registration is made in the Registration/Verification part. You will
get to the application through the icon Registration in the menu at the bottom
of the page. Then, you will get directly to the time registration menu.

You can choose to register time every day under Register/day or to register a
week at the time under Register/week.

The administrator can choose to give a user the right to register time and
products/services for other users. In the User selection list, choose the user
you want to register time for, then continue the registration as usual. 

Register/Day

Changing of Dates
When you have logged in, today's date will be displayed automatically. If you
want to change dates, you do that by using the selection lists. When doing
so, the data at the bottom of the page will alter, and you will see the date and
the time registered for that date, if any. You can also click Preceding and
Next in order to find an earlier or later date.  

Register Time
1. Select customer, project, phase and activity in the selection lists.

The only projects, phases and activities listed here, are the ones you
are a member of. Note, that if the administrator has chosen that it
should only be possible to register time on active phases and
activities, only these are available here. 

2. If you want, you can enter a comment in the Comment text field.

3. Select a time code.

4. Select the number of hours and minutes.

5. Click Add.

6. If you click the button Reset before you have clicked Add, the text
fields will be cleared and you can start over with your registration.
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Further down on the page you can see:

• Date
• Project
• Phase
• Activity
• User
• Comment
• Time Code
• Time
• Event (Change, Copy and Delete. You can find out how to use the

different events below.)
• Products/Services (You will find information on how to register

products/services under the heading Products/Services below.)
• The Sum of the time registered. 

Edit Time Registration
Note that when registrations have been verified, transferred to the invoice
details and/or when projects have been locked, they can no longer be edited
or deleted.

Edit
1. Click the link Edit by the registration you want to change.

2. All the data connected to the registration will now be displayed in
the text field in the upper part of the web browser.

3. Make your changes.

4. Click the button Save. The data you have updated are now altered. 

Copy
You can copy a registration, in order to register similar activities in an easier
way:

1. Click Copy by the registration you want to copy.

2. Make your changes, if any.

3. Click Add. The copied registration is now added.

Delete
1. Click the link Delete by the registration you want to delete.

2. Click OK in the pop-up window.

The registration is removed.
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Products/Services
You can register products/services in connection with each time registration.
The administrator and users with extended rights can enter suppliers and
products/services which you can select.

1. Click the icon with the cart. Make sure that the right date is selected
in the selection lists. If not, change it. 

2. Select customer and project in the selection lists.

3. Select phase and activity.

4. Select the supplier in the selection list to the left.

5. Select the product/service in the selection list to the right.

6. Enter the quantity, the unit used for the product/service and the cost
and price per unit. The total will be displayed automatically. Click
Add.

7. Repeat steps 2-6 if you want to register more products/services.

Edit Products/Services
There are three different events: Edit, Copy and Delete. You can view these
events in the row by the product/service registration. 

Note that when registrations have been verified and/or transferred to the
invoice details, they can no longer be edited or deleted.

Edit
1. Click the link Edit by the product/service registration you want to

change.

2. All the data connected to the registration will now be displayed in
the text field in the upper part of the window.

3. Make your changes.

4. Click the button Save. 

The data you have updated are now altered. 

Copy
You can copy a registration in order to register similar products/services in an
easier way:

1. Click Copy by the registration you want to copy.

2. Make your changes, if any.
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3. Click Register. The copied registration is now added.

Delete
1. Click the link Delete by the registration you want to delete.

2. Click OK in the pop-up window. The registration is removed.

Search for Registrations
You can make a search for your own product/service registrations made
earlier by browsing the selection lists for product/service registration. Select
user, time period and project, phase or activity. Finally, you select the sorting
order: by Project, by Date or by User name. 

Registration/Week
Compared to the menu Registration/day where each day is registered
separately, it is here possible to register for a week at the time. 

The pre-set week is always the present week, but if you want to register for
another week it is possible to change week in the lists at the top of the page.

This menu facilitates time registration since it, while registering time, also
gives an overview of all phases and activities worked on the selected week.
The selected projects, phases and activities are available for the whole week,
so if working with the same activity several days, it's possible to just enter
time, comments and choose time code. 

In the schedule, it is possible that for each activity see planned time,
registered time and estimated time left. The sum total of registered time per
day and registered time per project, phase and activity is in the end of each
row and column. 

Register Time
1. Make sure that selected user, year and week is correct.

2. Browse through the list for the customer, project, phase and activity
you want to register time on.

3. Write the time in the column for the day you want to register time
on.

4. In the window that pops up, select time code and write a comment
to your time registration. Close the window.

5. If it is mandatory to estimate how much time is left on the
project/phase/activity before the work is done, this time is entered in
the field Rest.

6. Save.

7. Repeat the steps above to register time for another activity, phase,
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project or customer. Do not forget to update the field Rest. Save. 

Verification
The administrator and users with extended rights can verify time and
product/service registrations. These rights are set for each user under
Administration > Register maintenance > Users. Select the user and click on
Rights. Thereafter, check the box for Verify time registrations and/or Verify
registrations of products/services. Do not forget to save. 

Note! Under Administration > Organisation settings > Verification, the function
Registrations must be verified before they can be shown on salary reports
and invoice details, can be found. If this function has not been selected, the
menu Verification will not be displayed, since verification is not necessary
then.

Verify Time
1. Select the date you want to verify up to in the date selection lists.

2. Select All users or one user you want to verify in the selection list.

3. Select if you want to sort the results by user, date or project.

4. Select that you want to verify time by marking the clock.

5. All time registrations matching your selections are now displayed.
Make sure the data is correct.

6. If the time registration needs editing, click the clock or make the
changes.

7. When the data is correct, mark the check box by the registration on
the main page, click Verify and then click OK in the pop-up window.
All the marked registrations will then be verified. Note that when a
verification is registered, it cannot be deleted.
Tip: To mark all check boxes, click on the word Verify above the
check boxes. To unmark them, click again. 

Verify Products/Services
1. Select the date you want to verify up to in the date selection lists.

2. Select All users or the user you want to verify in the selection list.

3. Select if you want to sort the results by user, date or project.

4. Select that you want to verify products/services by marking the cart.

5. All product/service registrations matching your selections are now
displayed. Make sure the data is correct.

6. If the product/service registration needs editing, click the Cart or
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make the changes.

7. When the data is correct, mark the check box by the registration on
the main page, click Verify and then click OK in the pop-up window.
All the marked registrations will then be verified. Note that when a
verification is registered, it cannot be deleted.

Edit a Registration Before Verification
1. Find the registration you want to edit before the verification.

2. Click the Clock or the Cart, depending on if it is a time or a
product/service registration you want to edit. A pop-up window will
open.

3. If you want to edit the data of the registration, you click the link Edit
under the heading Event. The data is then added to the registration
part of the window. 

4. Make the changes and click Add. 

5. If you want to copy the registration, click Copy. The data you copied
are now available in the registration part. Click Add.

6. If you want to delete the registration, click Delete.

7. Close the window when you have made your changes.

Reopen Verified Time or Products/Services
To regret an already verified time or product/service registration, follow the
instructions below:

1. Check the radio box to reopen a verification for time or
products/services.

2. Change the from-date in the selection boxes to get verifications for
dates after selected date.

3. Select the verification you want to regret.

Lock Time Registrations
If the administrator has chosen it to be possible to give a lock-date for time
registrations, you can set the date here. By locking a project to a certain date,
you prevent users from register and/or change times on the projects for dates
earlier than the lock-date. 

1. Select that you want to lock the project by marking the Lock.

2. Select the date in the selection box which you want to lock the
project to.

3. In the list to the left, the projects that you can choose from are
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listed. Mark the projects that you want to lock and click on the
arrows >> to move them over to the list on the right. 

4. When all projects you want to lock are moved, click Lock. 
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Reports
The Reports part of ProjectManager allows you to generate different kinds of
survey reports, linked to the working hours or the planned, registered or
billable time for one or several Projects. Select one of the Report Types from
the right-hand menu by clicking the Name of the Report you want to view.
The different reports present information on the level of the individual,
showing the time registered by a user. 

For some of the reports there are ready-made default reports. The name of
the report implies what the report will display. These reports can be used
when you want to get the information fast. The reports are example reports
and can be edited. They can also be used as a help when you want to create
your own reports.

Monthly Reports
The monthly reports are reports per individual and show the time that a user
has registered. 

Monthly Report
The Monthly Report offers a quick survey of the total amount of time a user
has registered during the month selected. The default settings display your
own working time for all Projects during the current month. You can also
study the time registered for other months. 

You can quickly find out what days you have worked, what you have been
involved in, and for how many hours. The time is summarized per day, week
and an entire month. If you you have forgotten to register your working time,
you will be able to see it here.

The reports followed by a star in the Reports list, are reports you created and
therefore can edit. For information on how to create or edit a report, see To
change the selection or create a new report, below.

You can easily change the time period by selecting the year and month in the
selection lists at the top of the report page.

To Change the Selection or Create a New Report
Click the button Edit to generate a more complex monthly report. You can
make a number of selections to view different types of time registered. The
various selections make it possible to generate reports which contain different
types of information. 

Note! If you select another option than All in the selection lists, a selection list
will be displayed in the report where you can make changes without having to
go back and edit the data.

1. Select the report you want to edit or select New report in the
Reports list.
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2. If you have the right to create public reports, select type of report.

• Private means that only the user creating the report can view
the report.

• Project leader means that only the project leader and the
administrator can view the report. 

• Public means that everyone can view the report.

3. Name the report if you have selected to create a new report. 

4. Select the contents of the calendar using the Time and Percentage
selection lists. The following types of registrations can be displayed:

• Working hours - your normal working hours.
• Planned time - those of your working hours that have been

booked for participation in different projects.
• Time registered - the time you have registered for the realization

of different phases and activities.
• Billable time - the time you have registered on billable time

codes. 

You can also view combinations of these registrations. 

The Percentage selection list is used to specify if you want to view the
selected time as a percentage share of another form of registered time. For
instance, this could be the billable share of the total time registered, or the
share of planned time in relation to the normal working hours. 

1. Select if you want to show the report to a certain group of users or a
specific user. You can choose a Private result unit, User group or
User.

2. Select a project group, i e All projects or Internal or External projects
exclusively.

3. If you are working with programmes, choose one here. 

4. Select a specific customer to display the information for this
particular customer, or select All.

5. Select project status among the different status a project has for the
moment, or select All. 

6. Select project type from the list of pre-set project types that you are
using, or select All.

7. Select the result unit for the project(s) you want to view, or select All.

8. Select one of the project leaders in the selection list, or select All.

9. Select a specific project, or select All.

© Artisan Global Software 



Manual | 31

10. Use the check boxes to the right under the heading Project
selection, to indicate if you want the report to display the time after
user properties as per Result unit, User group or User, or after
project properties as per Project group, possible Programme,
Customer, Project status, Project type, Project leader, or Project.
You can also combine these options to structure the report
information in different ways. Some combinations generate large
amounts of data, making the file very large. In such cases the
program displays a warning message to inform you that the time for
downloading the file could be very long. 

11. Click Save, to save your new report or to save the changes you
have made.

12. Click View, to save and generate the report. There is also a button
you can use to make a print-out of the report. For more information
on how to print a report, see Print report.

13. Click Edit to change the settings and generate another report.

14. To delete a report you have created, mark the report in the Reports
list and click Delete.

Registered/Day
This report is a detailed list showing time registrations, day by day. You will
first see your own report for the present month. Then, choose user (if
possible), and the year and month that you want to generate the report for in
the selection lists. What is shown for each day is information about customer,
project, phase, activity and number of hours spent on the activity and a sum
total of registered time for the day. The page is updated automatically.

You can print the report by clicking Print. For more information about printing
a report, see Print report.

Registered/Project
The report Registered/project displays a summary of the time worked each
month by an individual. The information is sorted by the projects the user has
been involved in. The report shows every registration of time made separately
for a project's phases and activities, but the time spent on the project as a
whole is also summarized. Furthermore, all the hours worked during the
month are summarized. You can change the selection to display another
month. The page is updated automatically. You can make a print-out of the
report by clicking the button Print. For more information on how to print a
report, see Print report.

Registered/Time Code
In the report Registered/time code you will see registered time per time code.
All time registrations are shown and summarized per time code. Also the total
time per month is presented. 

You can alter the time period by changing the year and month in the selection
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lists. The page is updated automatically. You can make a print-out of the
report by clicking the button Print. For more information on how to print a
report, see Print report.

Planned Time
In this report you can see your planned working time in a Gantt chart. The
time is registered in the order: Project, Phase, Activity. After each activity, the
total of the planned time is shown. A total of the planned time for the current
month is shown at the bottom of the column.  

Below the Gantt chart, you can view a resource graph of the planned
overtime, planned (working) time and working hours of the user in question. 

You can change the time period of the report by changing the year and
month in the selection lists. The page is updated automatically. 

You can make a print-out of the report by clicking the button Print. For more
information on how to print a report, see Print report.

Project Reports

Project Plan
This option can be used to display project plans, i e charts of the planning of
selected projects.

1. First, the project plan for the project you latest worked with is
displayed. A chart of the project's phases and activities is displayed
together with a time plan.

2. At the top left, you can select if you want to view a detailed plan for
an individual project member or if you want to get a display of all. If
you do not select anything in the selection box you will only see
basic planning of the project. 

3. Select if you want to view the plan based on one of the time
intervals Day, Week or Month. 

4. Select if you want to view the fields of the Planned time and/or the
Dates.

5. If you want to make a print-out of the plan, go to the radio buttons
in the upper section of the page and indicate if the page orientation
should be portrait or landscape. When this is done, click Print. For
more information on how to print a report, see Print report.

6. To display a project plan of another project, use the selection list at
the top of the page. You can make a search for Customer, Result
unit, Project status and Project, as well as Project number, ID and
Name. You will then get a list of projects where you also see the
start and end date for the project as well as the name of the
customer. Click on the name of the project that you want more

© Artisan Global Software 



Manual | 33

information about. 

Project Status
The report Project status provides you with a quick survey of the status of all
projects. The names of the projects are linked to a page with further
information on the phases and activities of the project.

1. First, you will see the project status of the project you latest worked
with. The report shows (for each phase and activity) the status,
person responsible for the project, planned time, time registered,
time remaining and expenses for Products/Services. At the bottom
of the page, you will also see the total of the various fields. The
status indicators are:

• Red cross – Inactive
• Yellow circle – Active
• Green tick – Concluded

2. To view detailed information on another project, you select the
project in the selection lists at the top of the page. You can make a
search for customer, result unit, status and project as well as
number, ID and name. In the generating list, click on the name of
the project that you want more information about. 

Project Report
The Project report can be used to customize your report for a specific project.

Note! If you select another option than all in the selection lists, a selection list
will be displayed in the report where you can make changes without having to
go back and edit the data.

1. If you want to create a new report, select New report in the selection
list. You can also select an already existing report

2. If you have the right to create public reports, select type of report.

• Private means that only the user creating the report can view
the report.

• Public means that everyone can view the report.

3. Select a time period in the selection list, or mark the time period in the
calenders. If you have marked No limits, the calendar will not be
displayed.

4. Select what you want to view in your report: Time registered, Planned
time, Time left, Individual registrations, Sum per user or
Products/services. If you select individual registrations, you can see
the data behind the figures, i e the selected user's registrations per
activity and occasion. Check the boxes to delete or add selections.

5. Under the heading User selection, select in the lists Result unit, User
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group and User, which users you want to view information about. 

6. Under the heading Project selection, you can select Project group,
Project status, Project type, Result unit, Customer, Project leader and
finally, the Project you want to base the report on.

7. Click View report.

8. If you have selected to include expenses for products/services, you
can click the link Products/services cost or price in the report, in
order to view a window where these figures are registered.

9. Click Close at the bottom right corner of the window to return to the
project report page.

10. You can print the report by clicking the Print symbol.

11. You can export the report to an Excel file by clicking the Excel
symbol. If you want to save the Excel file, click File > Save as, in the
opened Excel program.

12. If you want to edit the report, click Edit report and make your
changes.

13. If you want to view another project without changing report
parameters, you just select another project in the Projects selection
list, unless you selected to view all projects in your report parameters.
 

14. If you want to view another report, you just select another report in
the Reports selection list.

Result Report
In the result report you can view the projects' profitability. The report
compares the planned profitability, the actual profitability and the difference
between. This way, it is easy to see what economic consequences a delay
might result in. 

For each project, you can see the project's price model and the cost model
that was set in the project administration. In the columns below you will see:

• Planned income: Planned hours and the amount set in the project
administration.

• Planned cost: Planned hours and the amount set in the project
administration.

• Planned result: Planned income minus planned cost.
• Accrued income: The actual hours and the income they involve. 
• Accrued cost: The actual hours and the cost they involve.
• Accrued result: Generated income minus generated cost.
• Invoiced income from invoice details: The sum of the project's all

invoice details.
• Registered but not invoiced hours: The hours on the project that

© Artisan Global Software 



Manual | 35

have not yet been transferred to invoice details.
• Real income: Invoiced income plus the amount for not yet invoiced

hours.
• Real result: Real income minus accrued cost.
• Planned result: See above.
• Difference: The difference between planned and real result.
• Time planned minus time registered: Hours left on the project,

considering planned and registered hours.
• Real income minus planned income: The difference between real

and planned income.
• Difference: The difference between planned and real result. 

Follow-up report
This report is only visible if the setting Registration of estimated time left is
possible, is activated under Administration > Organisation settings >
Registration. Since the users themselves, under Register/Week, enter how
much time they estimate is left on a certain activity, you can here get a report
of how well a project or phase keeps the estimated time plan. 

1. Select the year and week that you want to display in the report in
the selection lists at the top left of the page. 

2. Select customer, project and phase, if any, in the selection lists at
the top of the page. If you do not select any phase, the whole
project will be displayed. 

3. You will now see all activities in the report. For each activity, you can
see the total of planned time, the total of registered time and the
estimated time left. The estimated time left is based on the entered
time left under Register/week by each user. If any user has not
registered the time left, it is calculated as all the planned time
remains. 

You can also see Delta, the difference between the planned time,
and the sum of the estimated time left and the registered time. In the
column Complete, you can see how much of the project that is
done. The percentage is calculated by dividing the registered hours,
by the sum of the registered and the remaining hours. You can also
see the due date of the project. 

List of Key Figures 
The key figures are for project leaders and administrators.

In the list of key figures you can view:

• The number of work days per member and week for the selected
project.

• The number of work days per week for the selected project.
• Invoice amounts and payments.
• Revenues per work day (registered accumulated payments/amount

© Artisan Global Software 



Manual | 36

of accumulated work days).

The key figures can be estimated in two different ways depending on the
settings selected in Organisation settings > Settings or in the project's basic
information: Expense and price information. At the bottom of the page, you
can select if all the hours worked are to be invoiced, or 8 hours per day only.

If you selected Invoice all hours, the program calculates: 

Key figure = Number of hours / 8.

If you selected Invoice a maximum of 8 hours per day, the program
calculates: 

If the number of hours is 8 hours or more/day/user: Key figure = 1. 

Otherwise: Key figure = Number of hours / 8. 

The total key figure is the total of a whole week's key figures.

The project leader can only view the key figures for the projects of which
he/she is a member, unless he/she has extended rights.

You can view the key figures of a project by making choices in the selection
list on the top. You can make a search by customer, result unit, status,
project or by entering part of the project number, ID or the name in the
search text field and then click Search. If there is more than one project that
matches your search, you will get a list with the results where you can click
on the name of the project that you want to view the report of. 

Time Reports

Time Report
The report Time report makes it easy to create time reports for one or more
projects where the registered time for a certain period of time is shown. The
time can be displayed either per day, week, month or year, or no interval of
time. If you do not choose any interval of time, the sum total will be shown for
all registrations of time for the selected time period. If you select any of the
other alternatives, the sum total will be shown for each day, week, month or
year. You can also make a selection among your projects. You can choose
from a large number of ways displaying your working time. 

Reports followed by a star can be edited, since these are reports you created
yourself.

Note! If you select another option than all in the selection lists, a selection list
will be displayed in the report where you can make changes without having to
go back and edit the data. 

1. If you want to create a new report, select New report in the Reports
selection list and then name the report. You can also select an
existing report in the selection list.
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2. If you have the right to create public reports, select type of report.

• Private means that only the user creating the report can view
the report.

• Project leader means that only the project leader and the
administrator can view the report. 

• Public means that everyone can view the report.

3. Select the time period you want to view. Either you select the period
in the selection lists, or you mark the from and to dates directly in
the calender. To view the calender you have to select Choose
period in the selection list. 

4. Select the time interval you want to use for grouping the information
in the report, either per day, week, month, year, or no interval of
time.

5. Decide if the sum total should be made per activity, phase, project
or user. 

6. Make a project selection to specify which project(s) should be
included in the report. You can base your selections on Project
group, possible Programme, Customer, Project status, Project type,
the project's Result unit, Customer, Project leader or Project.

7. To define what kind of data that should constitute your report, mark
one or more options in the lists of what should be visible in the
report. Click on the time reports you want to add in the list Content,
press CTRL to select more than one alternative.

8. Click Save to save the report or your changes.

9. Click View report. The report will be saved when you click View
report. 

10. At the top of the report, you find a list of the selections you have
made and explanations of any abbreviations. This is followed by the
time data, sorted by the time intervals you have selected.

11. You can select another report in the selection list and change the
time period by changing the dates in the calendar. 

12. Click Edit report to change the settings. 

13. There is a button to make a print-out of the report. For more
information on how to print a report, see Print report.

Time Graph
In this report you can view a graphic picture of different registrations. For
example your registered time or your normal working hours. 
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Note! If you select another option than All in the selection lists, a selection list
will be displayed in the report where you can make changes without having to
go back and edit the data.

1. Select the report you want to display in the selection list. Reports
followed by a star are reports you created yourself and can edit.

2. If you want to create a new report, select New report in the Reports
selection list and then name the report.

3. If you have the right to create public reports, select type of report.

• Private means that only the user creating the report can view
the report.

• Project Leader means that only the project leader and the
administrator can view the report. 

• Public means that everyone can view the report.

4. Select the time period you want to view. Either you select the period
in the selection list, or you mark the from and to dates directly in the
calender. To view the calender, you have to select Choose period in
the selection list.

5. Then select if the time should be summarized per day, week, month
or year.

6. Select what contents should be displayed by the two bars in relation
to each other. The alternatives are: Working hours, Planned time,
Time registered or Registered billable time.

7. Select project group, i e All projects or only Internal or External
projects.

8. If your organization is using programmes, select here if you want to
show information of all, or any specific programme. 

9. Select an individual customer if you only want to view the data for
this customer, or select All. 

10. Select project status from the list of different status types: All not yet
filed, Inactive, Active, Concluded, Cancelled, Filed, or All.

11. Select a project type from the list of types used, or select All. 

12. Select a result unit for the project(s) you want to view, or select All. 

13. Select one of the project leaders in the list, or select All.

14. Select which project the report should display, or select All.

15. Click Save to save the report.

16. Click View report to generate the report. The result is displayed as a

© Artisan Global Software 



Manual | 39

bar graph. Your selections are indicated above the graph. The page
also holds a button for printing the report. For more information on
how to print a report, see Print report.

17. Click Edit report to change the settings and generate another report.
 

18. You can select another report in the selection list and change the
time period by changing the dates in the calendar. 

Gantt Chart
In this report you can generate a Gantt chart of different registrations.

Note! If you select another option than All in the selection lists, a selection list
will be displayed in the report where you can make changes without having to
go back and edit the data. 

1. Select the report you want to display in the selection list. Reports
followed by a star are the reports you created yourself and therefore
can edit. 

2. If you want to create a new report, select New report in the Reports
selection list and then name the report.

3. If you have the right to create public reports, select type of report.

• Private means that only the user creating the report can view
the report.

• Project leader means that only the project leader and the
administrator can view the report. 

• Public means that everyone can view the report.

4. Select the time period you want to view. Either you select the period
in the selection list, or you mark the from and to dates directly in the
calender. To view the calender you have to select Choose period in
the selection list.

5. Then select the time unit to be displayed in the report: per week, per
month or per year.

6. Select the content level you want the report to display: projects,
phases, activities or users.

7. Decide if you want the report to display time columns and/or Date
columns. You can also select to graphical show grids between rows
and/or grids between weeks to easily see and interpret the Gantt
chart. Note that grids between weeks only will be shown if you have
selected the time unit week. 

8. Make, if any, selection of users. You can choose between result
unit, user group and user. 

9. Select the project group, i e All projects or only Internal or External
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projects.

10. Select programmes if used in your organization. Select Show all or
just the project belonging to a certain programme. 

11. Select an individual customer if you only want to view the data for
this customer, or select All.

12. Select project status from the list of different status types: All not yet
filed, Inactive, Active, Concluded, Cancelled, Filed, or All.

13. Select a project type from the list of types used, or select All. 

14. Select a result unit for the project(s) you want to view, or select All. 

15. Select one of the project leaders in the list, or select All.

16. Select which project the report should display, or select All.

17. Click View report to generate the report. The page also holds a
button for printing the report. For more information on how to print a
report, see Print report.

18. Click Edit report to change the settings and generate another report.
 

19. You can select another report in the selection list and change the
time period by changing the dates in the calendar.

Time Code Report
In the Time code report, you can generate a report for the different time
codes used for registering time in each project. 

Note! If you select another option than All in the selection lists, a selection list
will be displayed in the report where you can make changes without having to
go back and edit the data. 

1. Select the report you want to display in the selection list. Reports
followed by a star can be edited, since you created the reports
yourself. 

2. If you want to create a new report, select New report in the Reports
selection list and then name the report.

3. If you have the right to create public reports, select type of report.

• Private means that only the user creating the report can view
the report.

• Project leader means that only the project leader and the
administrator can view the report. 

• Public means that everyone can view the report.

4. Select the time period you want to view in the selection list. If you
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mark Choose period in the selection list, you can mark the time in
the calendar. If you choose another period, the calendar will no
longer be visible. 

5. Then select the sort order for the information in the report in the
three check boxes. The report will then sort the information in the
order you choose, for example first after time code, then customer
and last after project. Mark the check box Individual registrations, if
you want to be able to view individual time registrations.

6. In the time code selection, choose if you want some of the time
codes NOT to be included in the report. Mark that time code in the
list with included time codes and click on the arrows to move the
time code to the list with excluded time codes. The time
registrations that are made for time codes in the list of excluded time
codes will not be included in the report. 

7. Make, if any, selection of users. You can make the selection based
on result unit, user group and user. 

8. Select the project group, i e All projects or only Internal or only
External projects.

9. If your organization uses programmes, choose if you want the report
to be based upon one specific of these, or all. 

10. Select an individual customer if you only want to view the data for
this customer, or select All. 

11. Select project status from the list of different status types: Inactive,
Active, Concluded, Cancelled, Filed, All not yet filed, or All.

12. Select a project type from the list of types used, or select All. 

13. Select a result unit for the project(s) you want to view, or select All. 

14. Select one of the project leaders in the list, or select All.

15. Select which project the report should display, or select All.

16. Click Save to save the report or your changes.

17. Click View report to generate the report. The page also holds a
button for printing the report. For more information on how to print a
report, see Print report.

18. Click Edit report to change the settings and generate another report.
 

19. If you want to delete the report, you mark it in the Report list and
click the button Delete.

20. You can select another report in the selection list and change the
time period by changing the dates in the calendar.
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Estimated Time
This report is only visible if the setting Registration of estimated time left is
possible, is activated under Administration > Organisation settings >
Registration. The report is then also available as an icon in the list at the
bottom of the page. Since the users themselves, under Register/Week, enter
how much time they estimate is left on a certain activity, you can here get a
report of how well a project or phase keeps the estimated time plan.

1. Select the year and week that you want to display in the report in
the selection lists at the top left of the page. 

2. Select customer, project and phase, if any, in the selection lists at
the top of the page. If you do not select any phase, the whole
project will be displayed. 

3. You will now see all activities in the report. For each activity, you can
see the total of planned time, the total of registered time and the
estimated time left. The estimated time left is based on the entered
time left under Register/week by each user. If any user has not
registered the time left, it is calculated as all the planned time
remains. 

Salary Reports

Vacancy Report
In the Vacancy report, registered vacations of the selected period are
displayed. Through this report, you can see what the staffing situation is like,
within the company or within a certain user group, during the selected period.
It can also be used as a vacation planner.

The administrator can see the vacancy reports of all users.
In the selection lists, you can select what Time period, Time code, User group
or User you want to display in the report.

Click the Print button to print the report.

Salary Details
In this report, you can see what details the payment of salary is based upon.
You can view different entries which effect the salary. Furthermore, you can
see time registrations, vacations planned and other expenses, if any.

Salary details can be generated for an individual employee, or for a group of
employees simultaneously. You can only see the salary details if your user
level/role allows it. The administrator can view all details.        

Salary details can be generated either for all users simultaneously, or for a
selected group of users. 

There is an administrative setting which demands for registrations to be
verified before they can be viewed in the salary and invoice details. A result of
this is that time that has been registered for a certain project does not always
appear in the salary details. You verify registrations in the Registration part,
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under the menu Verify.

1. Select a time period in the calendar.

2. Select All users, Selection according to the one below, or Selection
per result unit.

3. If you selected the Selection according to the one below option, a
list of users is displayed. Select the user(s) for which you want to
generate salary details, in the left-hand selection list. Highlight a user
by clicking the name. Hold down the Ctrl or Shift key to select more
than one user at a time. Click the right-hand arrow to move these
users to the right-hand box.

4. If you selected the Selection per result unit option, you select the
result unit in the selection list. The users of that unit are displayed in
a list. Select the user(s) for which you want to generate salary
details, in the left-hand selection list. Highlight a user by clicking the
name. Hold down the Ctrl or Shift key to select more than one user
at a time. Click the right-hand arrow to move these users to the
right-hand box.

5. If you want to deselect a user, highlight the name and click the left-
hand arrow. The user will then be removed from the group of users
for which you generate salary details.

6. By checking the box for Show only users with registrations and/or
planned vacation, you can filter your selection even more. Users
without any time registrations or planned vacations will then not be
visible in the report. 

7. Click View report. If you have selected a large number of users, it
may take a while to generate the report. 

8. To print the report, click the Print button. If you want to create a
SIE4 file, click the button Create SIE4 file and follow the instructions.

Control Information
This report menu is only available for administrators and authorized users.
See Control information.

Project List
This list displays information about the daily turnover per project.
Visible headings:

• Customer
• Project
• Supervising director
• Project leader
• Price setting: Selected price model and selected invoicing model of
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registered hours (Invoice every worked hour or Invoice max 8 hours
per day).

• Estimated turnover excl. expenses: Set fixed price, without expense
rate.

• Expense rate: Expense rate in %. 
• Net turnover ytd: The sum of all invoices during the years, without

VAT and expense rate. 
• Working days ytd: All registered working hours during the year

divided by 8. 
• Director's work in %: The supervising directors working days on the

project in % of worked days in total.
• Daily turnover: Net turnover divided by registered hours.

The information in this list is gathered from the basic information of the
project, Cost and price information.

Order Information
In this report you can view all the information on the projects' offers and
orders.

There is information about: customer and project in question, who made the
recommendation to the customer, date of inquiry, date of initiated
negotiation, when offer was sent, when order and confirmation were verified,
who was the director attending, and estimated turnover and expense rate.

The projects are divided into groups according to project group and/or
status, and can be sorted according to date of inquiry, name of customer and
project name. 

Sales Forecast
This report displays a sales forecast for projects of the status inactive. They
are sorted and summarized according to project type.

• Estimated turnover exclusive of expenses: Fixed price, without
additional invoicing charge.

• Estimated turnover inclusive of expenses: Fixed price, including
additional invoicing charge.

• Occurrence probability: Based on the registrations for each project
and  given in per cent. 

• Sales forecast: Based on the fixed price * (occurrence probability /
100).

Selection can be based upon project group.

Recommendations
In the report Recommendations, you can view the name of the bank which,
and/or person who, recommended your company or organization to the
customer in question. The information is based on the project's order and
offer information.
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Registrations Report
This report is used when you want to view the registered working time of all
individuals for each customer and project. You can also compile this
information for all customers and projects in one report. 

A project is only available in the selection list if it is active and a user has
registered time to it.

Select the customer and project you want to include in the report, using the
selection lists at the top of the page. 

You can view the reports per day, week or month. The selection is made by
clicking one of the radio buttons. When you have made your choice, the
period selected is displayed in the from and to calenders. Consequently,
these dates indicate the period covered by the registrations report. 

Day
When you open the report, the days of the preceding week are displayed. If
you want to view another time period, simply change the dates in the from
and to calenders. The period you choose will then be displayed from Monday
to Sunday. 

Week
If you want to view a weekly report, click the Week radio button. This will
display a report of the most recent full week and the preceding six weeks.

Month
If you select Month, the program will display the report of the current month
and the five preceding months. 

If no working hours have been registered for the period you have selected,
this will be indicated in the Customer and Project selection lists.

View Report
When you click View report, the information is displayed according to the
selections you have made. 

If you want to make a print-out, click Print report. 

Result Report
With this report generator, you can create reports that show the financial
situation for the selected project.

The numbers are based upon the selected price- and cost models for the
project in question.

• Planned revenue: The number of planned hours multiplied by the
hourly rate for selected price model. 

• Planned cost: The number of planned hours multiplied by the hourly

© Artisan Global Software 



Manual | 46

rate for selected cost model.
• Planned margin: The difference between price and cost model.
• Result revenue: The number of registered hours multiplied by the

hourly rate for selected price model.
• Result cost: The number of registered hours multiplied by the hourly

rate for selected cost model.
• Result margin: The result revenue minus the result cost. 

Selection can be made to what time period you want to view in the report,
and if the numbers should be based on all registered time or just billable time.

The report can be exported to Excel and be printed. 

Create Result Report
Only project leaders and administrators can create result reports. 

1. Go to Reports > Control information > Result report.

2. Select New report in the list at the top left of the page.

3. Enter name of the report and decide if the report should be private
or public.

4. Select among the different settings and variables the information you
want to view in the report. To select more than one variable, press
the Ctrl-button when selecting the variables. 

5. Select the users for which you want to view the report.

6. Make your selection of the projects you want to view in the report.

7. Save.

8. Click on View report to view the generated report.

9. If you want to change any settings in the report, click Edit report at
the top of the page.

All selection lists where you make a choice, i e not choose all, will be shown
in the generated report where so that you easily can change your selections
in the report without having to go back to Edit report. 

Invoice Details
Invoice details can be generated, either for an individual project or for a group
of projects simultaneously.

Your invoice details constitute the basis of an invoice. Invoice details are
created when you are ready to send an invoice for a particular project. The
details can be generated by the project leader or the administrator/finance
staff. Invoice details can be generated for parts of an on-going project or for
an entire project, when concluded. 
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You can generate new invoice details or continue processing an existing
invoice details document. Make your selection in the right-hand menu. This
menu also includes the options Edit and History. All four menu options are
described below. 

New
Click New in the right-hand menu to generate new invoice details. The page
displayed includes all projects for which time has been registered within the
time period indicated in the date selection lists, and that have not yet been
invoiced. 

Note! If the Administrator selected Registrations must be verified before they
can be viewed in the salary and invoice details, in Organization settings >
Verification, a project's time has to be verified in order for a project to appear
in the invoice details. You verify registrations in the Registration part of the
program.

Specify the end date you want to include for the invoice details (today's date
is used automatically). This is done in the Date selection lists under Invoice up
to this date. Select all projects or only internal or only external projects.

All project names are links, which you can click to display the activities
included in the project.

1. Click the project you want to create invoice details for. You can
delete certain activities if you only want to create invoice details for
one or several parts of the project.

2. If you want to delete an activity, select the activity by clicking the
check box to the left of the activity concerned. 

3. The selection lists on this page can also be used to register country
group, result unit (of the project) and price type. It is important that
you select the correct country group in order to display the correct
VAT.

4. The price type options available are Fixed price, Price at project
level, Price at phase level, Price at activity level and Price at user
level. Click Set price, when you have selected a price type. Enter a
price in the pop-up window, then click Save or Save and close. If
you only click Close, your settings will not be saved.

5. You can preview the invoice details. Click the button Preview. 

6. If something is wrong, you can write off the invoice details by
clicking the button Write off. 
Note! A time or product/service registration that has been written off
can never be invoiced. It disappears from the system.

7. When you have made your settings and checked that they are
correct, click Create new invoice details. When you have created the
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new invoice details, the information will be displayed automatically
under the heading Edit. For more information on how to work with
invoice details, see Working with invoice details below. 

In Progress
In the menu Invoice details > In progress, all existing invoice detail documents
are listed. You can view the invoice number, date of creation, customer
name, project name and amount. 

More information on how to work with invoice details will be found here
below.

Edit
From the sub-menu In Progress, select the invoice details you want to open
by clicking its number. When you click a number, you will automatically be
transferred to the subheading Edit.

You will now be able to view the following information: Invoice details,
Customer, Project, Text, Quantity, Price and Amount.

More information on how to work with invoice details will be found here
below.

Working With Invoice Details
When you have selected an existing invoice details document, or created a
new one, the invoice details page is displayed. The invoice details can be
edited. You can also adjust the width of the columns of the invoice details.
Large numbers that do not fit the column width are displayed as # signs. This
is easily corrected by making the column wider. It is important that you
remember to save any changes you make, by clicking the Save button at the
bottom of the page! 

The next step is to indicate the viewing mode of the invoice details. The
alternatives available are: per project, per phase or per activity, as well as a
total per time code and/or per product. Furthermore, you can select to view
only totals or to view all time registrations. If you select to view all time
registrations, you can also select if you want to view a user name or an
account.

At the top of the page, to the right, you find the button Invoice header. Click
the button to display a template for the invoice header. This template can be
edited. If you make any changes, click Save and then Close. If no changes
have been made, only click the Close button.

If you want to remove the invoice details, you can click the button Invalidate.
Any time registered that is included in the invoice details concerned, then
becomes available for use in a new invoice details document. Confirm that
you want to invalidate the invoice details. 

You can add information by inserting new rows. 
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1. Indicate where you want to insert the row, by clicking the grey box
to the left of the activity. The row you have selected is now
displayed in color, which makes it easy to see what row is selected
and where the new row will be inserted. The text on the row
selected will be moved down one step, after you have inserted the
new row.

2. Click Insert row.

3. Enter the information in the row concerned, by clicking the fields. 

4. Click Save. A pop-up window opens to confirm that the information
has been saved.

If there are phases/activities that are not supposed to be included in the
invoice details, you can delete them. Note that these rows cannot be
recreated and that the working hours you delete will not be included in the
invoice details. 

1. Select the row/registration you want to delete.

2. Click Delete row. 

3. Click Save.

To make a print-out of the invoice details, click Print. The invoice details are
printed on your printer.

You can also print the invoice details as a PDF file by clicking the button PDF.
Your details are then turned into a PDF file and opened in Adobe Reader,
where you can print the file.

When you have finished processing the invoice details, click Ready for
invoicing. This means that you make it possible for the administration or
financial department to retrieve the details in order to create an invoice. When
you click Ready for invoicing, a pop-up window opens to inform you that
invoice details that are ready for invoicing can no longer be edited. Click OK if
you want to lock the details from changes, if not, click Cancel. 

History
At the bottom of the right-hand menu you find the option History. By clicking
this option, you display information on invoice details that have not yet been
invoiced or invalidated. These details can be opened here for editing. 

All your invoiced projects are displayed on the History page. By selecting
which column to use for sorting the invoices, you can control in what order
the entries of the list are displayed. At the top of the page there are four radio
buttons with the alternatives: invoice details, customer, project number and
project. You can also specify if you want the history to be sorted in
descending order.  
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Open for Editing
Click the button Open for editing if you want to change anything in the details.
See the heading Edit invoice details for more information. 

View Invoice Details
Click View invoice details to view the details.
This page allows you to view other details, which you can search by number
or customer. When you have made your search, you can browse through the
different details by clicking the arrows at the bottom left of the page.
You can select to only view the details of the customer that is selected in the
selection list Customer, by marking the box Browse per customer.
For more information on the invoice settings of the invoice details, and on the
settings of the invoice header, see the heading Working with invoices. 

Invoice
Invoices can only be created by the administrator/financial staff and users
with extended rights. An administrator can always create invoices even if
there are no invoice details. 
You can create a new invoice or open and work with an existing, in progress,
invoice. Use the options in the right-hand menu to make your choice. This
menu also includes the button Edit. 

New
Click the button Create new invoice. You can start with an existing invoice
details document or create a new invoice without details being generated. If
you create an invoice for which there are no invoice details, the invoice
generated is blank and you must enter all the information yourself. 

1. Select View all customers or Only customers with invoice details.

2. The alternative View all customers will display a list of all customers.
Select the customer you want to invoice and click the radio button
to the left of the customer name.

3. The list to the right will display the current invoice details of the
customer. If there are several details, you can omit the details you
do not want to include in the invoice. You do this by deselecting the
box in front of the details. Then click Create new invoice.

4. If you choose to create an invoice without details being generated,
you click the radio button to the left of the customer you want to
invoice, and click the button Create new invoice. A blank invoice is
generated where you must enter all the information yourself. 

5. The invoices you have created and saved are available under the
menu option In progress in the right-hand menu.

6. Read more about how to work with invoices below, under the
heading Working with invoices.
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In Progress
In the menu Invoice > In progress, all existing invoices are listed. You can
view the invoice number, date of creation, customer, and amount. Select the
invoice you want to open by clicking its number. 

When you open an invoice, the program automatically displays a page with
detailed information about the invoice. At the same time you are automatically
transferred to Edit. Read more about how to work with invoices below, under
the heading Working with invoices. 

Edit
1. Click In progress in the right-hand menu. The page displays a list of

existing invoices and you can view the following information on the
invoice: invoice number, date when it was created, name of the
customer and amount.

2. Select the invoice you want to edit by clicking the invoice number. 

3. You are automatically transferred to the menu Edit and the invoice is
opened for editing. Save when you have made all the changes you
want. 

Read more about how to work with invoices below, under the heading
Working with invoices. 

Working With Invoices
When you have selected an existing invoice or created a new invoice, the
invoice concerned is displayed. 

At the top of the page, you find the button Invoice header. Click this button to
open a template for the invoice header. This template can be edited, which
means that you can change the information. If you have made any changes,
click Save and close. If no changes have been made, click the Close button.

The next step is to define the mode for viewing the invoice, which is made by
clicking Settings. You can view the total per project, phase or activity, as well
as a total per time code and/or per product. You can also select to view only
totals or to view all time registrations. If you select to view all time
registrations, you can also select to view the user name and/or the account
number.

If you want to remove the entire invoice, you click the button Invalidate. Any
time registered that is included in the invoice concerned, then becomes
available for use in a new invoice details document. Confirm that you want to
invalidate the invoice. 

You can add information by inserting new rows. 

1. Indicate where you want to insert the row by clicking the grey box in
the margin, to the left of the activity. You can only select rows where
information has already been entered.
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2. Click the button Insert row at the bottom of the page.

3. Enter the information you want in the row concerned by clicking the
text fields. You can move between the text fields by pressing the tab
key. 

4. Click Save. The information in the row that you selected is now
moved down one step, so that the new information appears in the
row you selected. 

If there are entries that are not supposed to be included in the invoice, you
can delete them. Note that these rows can not be recreated and that the
working hours you delete will not be included in the invoice. 

1. Select the row you want to delete by clicking the check box in the
margin, to the left of the activity.

2. Click Delete row. Click OK in the pop-up window.

3. Click Save. A pop-up window opens to confirm that your changes
have been saved. 

To make a print-out of the invoice, click Print. The invoice is printed on your
printer.

You can also print the invoice as a PDF file by clicking the button PDF. Your
invoice is then turned into a PDF file and opened in Adobe Reader, where you
can print the file.

When you have finished processing the invoice, click Ready for accounting.
When an invoice has been entered in the accounts, it can no longer be
edited. Click OK in the pop-up window if you want the invoice to be entered
in the accounts. The invoice is saved in the Invoice journal. This journal is
accessible via the Invoice journal option at the bottom of the right-hand
menu. An invoice has to be printed before it is entered in the accounts.

Invoice Journal
Under the heading Invoice journal, you find a list of all the invoices that have
been entered in the accounts. You can also register payments of your
invoices. 

Note! If the VAT accounting of an invoice does not seem to be correct, check
the country group you have selected for the customer, since that will decide if
the customer is subject to VAT or not.  

New
You can create a new invoice journal by clicking Create new invoice journal
under the heading New, in the right-hand menu. A list of invoices that are
ready to be entered in the accounts is displayed.
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1. Click New in the menu.

2. Select which invoice you want to create an invoice journal for by
clicking the check box to the left of the invoice. 

3. Click the button Create new invoice journal. Click OK in the pop-up
window, if you want to create a new invoice journal. 

Register Payments
When you want to register that an invoice has been paid for, you click the
menu Open under the heading Invoice journal.

1. Mark the row with the invoice in question.

2. Click the button Register payment. A pop-up window is opened,
displaying information about the invoice, such as: Customer, Invoice
number and the Amount paid. Today's date is pre-set, but you can
change the date in the selection lists. When the data is correct, click
Save.

3. If you want to edit the registered payment, click Edit next to the paid
amount. Make your changes and save.

4. If you want to delete the payment, click Delete.

5. Close the window when you are finished registering the payments.

Open
When you click Open in the right-hand menu, the program displays a list of all
the invoices that have been entered in the accounts. The list is displayed in
ascending numerical order. When you open an invoice, all the information
available on the invoice is displayed. 

1. Go to Sort projects by, and select if you want invoices to be listed
by journal, invoice or by customer.

2. Under Sort order, you can also list the invoices in descending order.

3. Select the invoice you want to open by clicking the row concerned.

4. Click the button Open invoice at the bottom of the page. This will
display a page with detailed information on the invoice concerned.
At the same time, you are automatically transferred to the heading
Edit, in the right-hand menu.

Edit
In order to use the Edit option you must have selected and opened an invoice
first.

1. Select an invoice and click Open invoice.
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2. At the top of the page you define the viewing mode of the invoice.
Click Settings and select your settings. The invoice is updated
automatically if you change your settings.

3. If you click the button Invoice header, you display a template of the
invoice header. This template can be edited. Change it as desired
and click Close.

4. The only thing you can change in the invoice journal is the account.
You do this by clicking the row that you want to edit and enter the
new account number. The account number is only visible if you have
chosen Show all registrations and then Show account under
Settings. Click Save when you have made your changes. 

5. If you want to make a print-out of the invoice, click Print.

6. At the bottom of the page, you find a number of buttons. The arrow
keys with a vertical line takes you to the first (left-hand arrow) or last
(right-hand arrow) invoice of the invoice journal. The arrow keys in
the centre takes you to the previous (left-hand arrow) or next (right-
hand arrow) invoice in numerical order. By checking the check box
next to Browse by customer, you only display invoices that belong
to the customer selected.

Lists
Under Accounting records, you can generate a background document
required for book-keeping purposes. This document includes all the
information you need and can be used for manual entering into your
accounting software package. 

1. Select the invoice journal you want to transfer. 

2. Click Create list.

3. A pop-up window displays summary information on the invoice
journal and the accounting records. Make a print-out of the
summary and save it with your vouchers. 

At the top of the page, under Invoice journal, there is a list of invoices
included in the journal, together with the account number, result unit, project,
debits and credits. The lower section is an accounting record with a summary
per account. It displays the accounts included in the journal, as well as the
result unit, the project and debits and credits. Consequently, it offers a survey
of the transactions in the accounts of the journal. This information can be
transferred manually to your accounting software.

1. If you select List invoices by number, enter the invoice numbers to
be included. Use the boxes From invoice number and Up to invoice
number. Select sorting order of the list. It can be sorted per invoice
number, per date or per customer. Click Create list. A new window
now displays a list in numerical order of the invoices that are
included in the interval you indicated.
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2. If you select List invoices by result unit, use the selection list to
specify what result unit the list should be based on. Select the
account numbers and invoice numbers to be included. Click Create
list. 

3. If you select List invoices by account number, specify the account
numbers and invoice numbers to be included in the list. Click Create
list.

4. If you select List invoices per customer, select to base the list on all
customers or a specific customer. Specify the invoice numbers to
be included in the list. Click Create list.

5. If you select List unpaid invoices, specify last date of payment. Click
Create list. 

6. If you select List payments per invoice, specify the invoice numbers
to be included in the list. Then select sorting order. The list can be
sorted per invoice number, per date or per customer. Click Create
list.

When you have clicked Create list for any of the alternatives, except the last
one, a new window displays the list and you can print it.

Create SIE4 File
Under SIE4 export, at the bottom of the right-hand menu, you can create a
SIE4 file. This file format is handled by most accounting software. The SIE4
files are used to export project information, which has been registered in
ProjectManager, to your accounting system. 

1. Indicate the invoice journal number you want to include in the SIE4
file, in the text field.

2. Select if you want it summarized or detailed.

• Summarized: all the invoices in the selected journal are
gathered in one voucher only, and summarized by account,
result unit, and project. 

• Detailed: every invoice in the selected journal is placed in a
separate voucher, with each invoice as one transaction. 

3. Click Create SIE4 file. Follow the instructions in the pop-up window.

4. Click Close. 

Print Reports

Print Reports - Page Orientation
1. Click the Print button on the page of the report concerned.
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2. Click the button Settings in the printer settings window that is
opened.

3. Select portrait or landscape. 

4. Click OK.

Print Reports - Background Images and Colors 
Sometimes Internet Explorer does not show background images and colors
of a printed report. For example, if the different grey tones of the reports do
not show when you make a print-out, the settings of your web browser might
be the problem.

How to correct this:

1. Open the Tools menu of the web browser.

2. Select Internet options.

3. Click the button Advanced in the upper section of the window.

4. Go to the heading Printing.

5. Select the option Print background colors and images.

Print Reports - Edit Page Header and Footer
How to remove automatically inserted page headers and footers in Internet
Explorer.

1. Open the File menu.

2. Select  Print set-up. 

3. A small window is opened. Delete all text in the boxes by headers
and footers.

Print to Excel
Click the Excel icon next to a report to transfer it to Microsoft Excel. In some
cases this action first opens a window containing a link (which you should
click) to the file. Then a warning and a question, Open file or Save file, are
displayed. Select the alternative you want. The file is a text file, and therefore
the file name extension is .txt. Select Save the file as an Excel document. You
do this in the box below the name of the file, in the window Save as
(Windows standard). This will automatically change the file extension to .xls. 

If the file is opened directly in the web browser and you are unsure of how to
save the report: make a change in one of the cells and then close the
window. This will prompt a question if you want to save the file, and then you
can proceed naming and saving the file in the usual way.
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Administration
Depending on what rights the administrator has given you, you can see and
edit different things. If there are some of the headings below in the manual
that you can't see in the application, it's probably because your organization
is not using that feature, or that the administrator has chosen not to give you
that right. 

Register Maintenance

User
Under Users, at the top of the menu, you can display a list of all active users
registered in ProjectManager, or just yourself depending on your rights. By
clicking the name of a user under the heading Family name, First name, at the
left of the page, you will display all the registered information on the user.

Each user can edit his or her personal information, but the administrator and
users with extended rights can edit the information of others and register new
users in the system.

New User 
Only the administrator and users with extended rights can register new users
in the system. 

You need to work out how the terms user group and result unit should be
used within your organization. The project result unit is the unit which enters
the income from the project in the accounts. Additionally, the user belongs to
a result unit which can be used to generate reports on time registration etc. 

The user group is a way of structuring the various fields of competence within
your organization. These two terms are not in any way hierarchically
subordinate to each other, but based on a user approach. A user group can
consist of employees from different result units. 

A user could also be involved in a project which is administrated by a result
unit other than his/her own. However, you can decide to link users to user
groups in such a way that they match the result units. 

1. Click Users under the heading Administration.

2. Click New user. 

3. Enter the information. You must enter information in the fields
marked with a star. Note that all user names have to be unique.

• Employee number
• First name
• Family name 
• Birth date 
• Address 
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• Postal code 
• Town  
• Phone number
• Fax
• Mobile phone 
• E-mail 
• User name
• Password  
• Language 
• User role  
• User group 
• Result unit  
• Cost per hour
• Price per hour

 
This is also where you specify the sorting order of the projects. The following
sorting order options are available: 

• By project number 
• By project name 
• By project ID
• By most recently used 

You can also specify the time and date format. The user's registered worked
time will be displayed either by:  

1. The number of hours in decimal format (e.g. 2.75): hh.hh.

2. The number of hours and minutes (e.g. 2:45): hh:mm. 

You can also choose to restrict the user's access rights to the time
registration (TIME), to limit the users interface. The user will then not have
access to the menus Project, Project administration, Administration and
Manual. Check the box for Only TIME, for this option. 

User Rights
When a user is registered, he or she automatically gets access to the
standard rights which has been set for that user role by the administrator.
Individual rights can then be set for each user. 

Click the button User rights, next to User role. Select the rights for the user.
Save and close.

For more information on the different levels of rights, see the heading User
rights under the heading Organisation settings.

Search User
At the top of the page there is a search function. Fill in a few letters or first or
family name. Then click Search active. You will display only the users whose
names contain the letters or names in question. To go back to the list
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displaying all users, you click the button Search active without entering a
search word.  

To the right of the search buttons, there is an Excel icon. Click it if you want
to open an Excel file of the users. When you click the icon, a pop-up window
will open with the text Click the link to open your user register. Left-click to
open the file, and right-click to select Save target as or Save link as to save
the file on your computer.

Search Inactive
To display an inactive user, you enter parts of or the whole name of a user in
the search field. Then click the button Search inactive. You will display a list of
all the inactivated users. If you click the linking name, you will display the user
information and the user is reactivated.

Inactivate User
A user can not be completely deleted out of the system because this would
result in losing history over the projects the user has been part of. Instead it's
possible to inactivate the user, and in this way remove the user's possibilities
to use the system, and it also results in the user no longer being available for
the projects. 

First of all, you need to find the user concerned by using the search function. 

1. Enter the full name or parts of the name in the search field at the top
of the page. Click Search active.

2. Click the user's name to display the user information. 

3. At the bottom of the page, you find the button Inactivate user. When
you click it, you are asked to confirm that you want to inactivate the
user. If you want to, you can activate the user again. 

Activate User
In order to find an inactivated user, you enter the full name or parts of the
name in the search field and click the button Search inactive. You only need
to click the user's name to make him/her active again. 

Import User
You can also add a user to ProjectManager from an external register. Click
Import.

1. The page displays a column with examples on how to structure the
information so that it can be added to ProjectManager's user
register. Use the codes under the chart to select the user role within
the system. Click Example file to open it in a new window. Remove
the example users in the chart and add your information. Make sure
to follow the same structure. Information added to a row which is
otherwise empty, will be considered as incomplete and you will
receive an error message. There can only be empty rows when the
last user has been added to the document.

© Artisan Global Software 



Manual | 60

2. Save the file to your hard disk when you have added the correct
information. If you have made any changes to the document, you
will be asked to save these when you close the window. Click Yes
and save the register data in the file format Text, tab delimited,
(*.txt). If the file is structured in exactly the same way, but saved in
another format, e g Excel (*.xls), you still have to save it again as a
tab delimited text file. 

3. At the bottom of the page, the button Browse can be used to find
the .txt file in the computer's directory. Click Browse, find the file
and double-click it.

4. Then click Get text file, to register the data to the program. The user
name is unique for every user in the user register. If two users have
identical user names, they are considered as duplicates. The users
that are to be imported are displayed in a chart. A user's status can
be: valid, duplicate (in blue) or duplicate (in red). Duplicate in blue
means that this name occurs more than once in the file you are
trying to import. You have to delete or change the user names of
these duplicates in order to continue the import. Duplicate in red
means that the name already exists in the user register. A duplicate
in red can remain, but if the import is completed, the old user
information in the data base is replaced by the information that is
imported. Click the link Edit/delete in order to edit the information of
the user. Make your changes and then click Save or click Delete to
delete the user from the import file. Close the window when you are
finished.

5. When no duplicates in blue remain, you can click Complete import.
(Note that the duplicates in red will replace the current data of the
user in question in the register of users.) When you click Complete
import, the data is entered in the data base. 

User Groups
User groups can be used for structuring the resources within your
organization in different ways. Your user groups do not necessarily have to be
subordinate to the result units. In fact, they can be used in a very flexible way.

1. Click Administration > User groups.

2. Existing user groups are listed together with the user names as
links. If you want to change the name of a group, you simply click
the name.

3. Make your changes in all languages used in the system and click
Save. 

4. In order to create a new user group, click the button New user
group. The system displays a text field for each language used in
the system. You can now enter the name of the group in the
languages you want to use. All languages indicated under

© Artisan Global Software 



Manual | 61

Administration > Organisation settings > Languages, must be
entered. 

Customers
In the register of customers, you can search and edit information on your
customers. 

1. Click Customers in the menu to the right.

2. You can display information on an organization in two ways. Either
you click the organization or you use the search function by entering
parts of the name of the organization in the text field. Then click
Search.

3. If you want, change the information. Save your changes by clicking
Save.

4. You can remove a customer by clicking Delete.

Adding a New Customer
When you add a new customer, the following information can be registered:

• Folder name
• Organisation
• Customer no
• Organisation no
• Department
• Address
• Visiting address
• Postal code
• Town 
• Country
• Phone number 
• Fax 
• Web site
• Country group
• Extra information
• Contact person

The text fields marked with a star are mandatory to fill in. 

If you want to be able to use the new customer's information when invoicing,
all text fields should be filled in. This information can be added later, but the
work is facilitated if this information is entered when working with
administration.

Note! The reason for the country group (domestic sales, trade market sales,
international sales) is that this information forms the base for the VAT
calculation when invoicing, and determines which account number to use. 
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• Domestic sales: These customers are subject to VAT. The VAT is
displayed on these invoices.

• Trade market sales: These customers belong to the European Union
and have to be included in the VAT accounting to the government.
The VAT is estimated and VAT rows are generated, but the rows are
not shown on the invoice. The VAT rows are only included in the
SIE4 export and the Invoice journal lists with a balance of 0 (The lists
include rows of debits and credits which give the balance 0).   

• International sales: These customers are not subject to VAT. The
VAT is not displayed on these invoices.

1. Click the button New customer at the top of the page.

2. Fill in the data. Rows marked with a star have to be filled in. Save.

3. Click New contact person to register a contact person.

4. Fill in the data. Rows marked with a star have to be filled in.

5. These contact persons will be possible to select for other projects
that this customer is involved in.

6. Click the button Back to get back to the saved information.

7. Click New contact person once more, if you want to add another
contact person. Click the linking name to edit the information of the
contact persons already registered. 

8. Save.

Print a Register of Customers in Excel
To the right of the search button, there is an Excel icon. Click it if you want to
open an Excel file of your customers. When you click the icon, a pop-up
window will open with the text Click the link to open your register of
customers. Left-click to open the file, and right-click to select Save target as
or Save link as, to save the file on your computer. 

Programmes
If it under Administration > Organisation settings > Settings, has been
selected to use programmes, you administrate these under Administration >
Register maintenance > Programmes. Only administrators can add
programmes in the system. 

Using programmes is a way to group projects for one customer. This can be
useful when having complex customer projects that contains several parts.
Create a programme to group the different parts of the projects that you add
in ProjectManager. You can easily get statistics over each one of the
individual projects, but also for each programme.

For each programme you add information about:
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• Customer.
• Name in all languages used in the system.
• Description in all languages used in the system. 

Add New Programme
• Click on New programme.
• Fill in the information. The fields with a star are mandatory.
• Save.

Administrate Programmes
• Click on programme in the menu on the right.
• Click on the programme you wish to administrate in the list. 
• Edit the information.
• You can also delete the programme by clicking Delete.
• Save.

Suppliers
In the register of suppliers, you can search and edit information on your
suppliers. 

The text fields marked with a star you have to fill in. The following information
can be registered:

• Organisation
• Supplier no
• VAT no
• Short organisation name
• Address
• Visiting address
• Postal code
• Town 
• Country
• Phone number 
• Fax  
• Web site
• E-mail
• Supplier description
• Contact person

Adding a New Supplier
1. Click the button New supplier.

2. Fill in the data. Rows marked with a star have to be filled in. Save.

3. Click New contact person, to register a contact person. Fill in the
data. Rows marked with a star have to be filled in. 
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4. Click New contact person once more, if you want to add another
contact person. 

5. Save.

6. The contact persons are listed to the left of the button. Click the
linking name to edit the information of the contact persons already
registered. 

Print a Register of Suppliers in Excel
To the right of the search button, there is an Excel icon. Click it if you want to
open an Excel file of your suppliers. When you click the icon, a pop-up
window will open with the text Click the link to open your register of suppliers.
Left-click to open the file, and right-click to select Save target as or Save link
as, to save the file on your computer. 

Products/Services
Only the administrator and users with extended rights can enter information
on the products/services in the system. The information on products/services
is used when registering the use of products/services for a project.  

New Product/Service
To add a product/service to a new supplier, you first go to Suppliers and add
the supplier, then back to New product/service.

1. Click Products/services in the right-hand menu.

2. Click New product/service.

3. Enter the information. Select if the product/service should be
included in the salary details by checking the check box. Then
select the salary type.

4. Save.

Administer Products/Services 
1. Click Products/services in the right-hand menu.

2. Select the product/service you want in the selection list.

3. Edit the data.

4. To edit the name of the product/service, click the button Other
languages/edit. Here, you can edit the name and description in all
languages registered in the system.  

5. You can also remove the product/service by clicking the button
Delete this product/service.

6. Save.  
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Project Types
The administrator can register project types that are frequently used within
your organization. Other users can also be given this right. This way project
leaders can use a generic model when setting up new projects and then
adapt the model to suit the particular project concerned. 

A project type consists of a number of phases, where each phase includes a
number of activities. All phases and activities can be administrated using the
Phases/activities option in the right-hand menu. You can then link a number
of phases to the project types.

New Project Type
1. Click New project type, at the top of the page.

2. Enter the name of the project type. 

3. Enter a description of the project type. 

4. Click Save. You will now come to a new page where you can add
and delete phases for the new project type. You can also enter a
description of the project type using the languages available in the
system.

Administrating Project Types
Select the project type in the selection list. The name of the project type
selected, which you can now administrate, is displayed in the text field at the
top of the page. If you want to administrate some other project type, you
enter the full name, or parts of it, in the search field above the text field.
Below the row of buttons, you can see all the phases and activities that are
currently included in the project type you have selected.

Project Type in Other Languages
You can edit the name and description of the project in all languages used in
the application. 

1. Click Project type in other languages.

2. You can update the project type in all languages available. All
languages registered in the system under Administration >
Organisation Settings > Languages, will automatically be given as
options here.

3. Click Save. 

Add Phases to an Existing Project Type
This is where you can add phases and activities that are already registered in
the system. If you want to add a completely new phase or activity, you should
go to the subheading Phases/activities. 

1. Click Add phases. A small pop-up window will open.
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2. Select the phase you want to add to the project type in the selection
list. When you have selected a phase, you will also be able to view
the activities included in the phase.

3. Click Add.

4. Repeat steps 2 and 3 to add more phases. 

5. When you have finished adding the phases you want to include in
the project type, either click Close or Add and close. 

Delete/Inactivate Project Types, Phases and Activities
You delete an entire project type by selecting the project type you want to
delete or inactivate in the subheading Project type. Then click the button
Delete/inactivate. 

Click OK in the pop-up window if you want to delete the project type, if not,
click Cancel. 

If you want to delete a phase or an activity that is included in a project type,
use the recycle bin icon. The recycle bin icon is to the far right of each row,
under the heading Delete in the list of phases and activities.

If you click the linking phase or activity name, the description registered for
each phase and activity will be displayed. 

Numerical Order of Phases and Activities
You specify in what order phases and activities should be presented by
registering the numerical order under the heading Order.

Double-click any of the boxes under the heading Order, and enter the
numerical order you want for the phase or activity. Repeat until all phases and
activities are numbered in the order of your choice.

Phases and Activities
In the administration section of the program, you register project types,
phases and activities, which all project leaders can use in their work. A phase
consists of a number of activities. 

First you create a phase and then a number of activities that you link to the
phase. 

Register a New Phase
1. Click Phases/activities under Register maintenance in the right-hand

menu. 

2. Click the button New phase. 

3. Enter the name of the phase. 
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4. Enter a description of the phase.

5. Click Save. 

When you have saved a phase, the system displays a new page. Here, you
can add activities linked to the phase, specify languages for the phase or
delete the phase.

Edit an Existing Phase
You can also select other phases. Either you click the phase in the selection
list, or you search for the phase using the name or parts of the name in the
search field at the top of the page.

Phase in Other Languages
1. Use the list of existing phases and click the name of the phase you

want to describe in other languages. You can also make a search
for the phase by entering the name or parts of the name in the
search field at the top of the page. Click the name of the phase.

2. When the information page with the name and description of the
phase is displayed, click Phase in other languages. 

3. You can now update the phase in all languages available in the
system. 

4. Click Save and close when you are finished.

Adding an Activity to the Phase
1. Go to the list of existing phases, and click the name of the phase

you want to work with. You can also make a search for the phase
by entering the name or parts of the name in the search field at the
top of the page. Then click the name of the phase.

2. Click Add activity.

3. Enter the name of the activity. 

4. Enter a description of the activity.

5. If you want to add more than one activity, click Add and repeat
steps 3-5. 

6. Click Add and close when you are finished.

Activities in Other Languages
You can edit the activity descriptions and names in all languages available in
the application. 

1. Select a phase in the same way as above.

2. Click the link Edit next to the activity you want to edit in other
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languages. 

3. You can now update the activity name and description in all
languages registered in the system. 

4. Click Save. 

Delete Phase
1. Click the button Delete phase.

2. Click OK in the pop-up window if you want to delete the phase, if
not, click Cancel.

Delete Activity
1. Click the recycle bin icon, on the right-hand side of the row with the

activity in question.

2. Click OK in the pop-up window to delete the activity, if not, click
Cancel. 

Calendar Maintenance
The calender and normal working hours are administrated and updated in the
same way for the project leader as for the project member. The administrator
and users with extended rights can administrate the time of all users and/or
their own times. 

Calendar
If you want to use the resource utilization information when planning a
project, you need to define the working hours for each project member. The
working hours are set by the administrator or the user concerned under
Administration > Calendar maintenance. 

If you have the right to administrate other users' calendar, you will see two
selection lists called User group and User at the top of the page. 

These lists are always displayed when you are editing calendar information.
The selections made in these two lists determine the number of users
affected by the activities you implement, for instance when you edit normal
working hours and register vacations. Users that only have the right to edit
their own calendar, will see their own name at the top of the page and can go
right to point 3 below. 

1. The User group selection list is used to indicate which user group
your calendar changes should apply to, or if the changes should
apply to all users. You define these user groups under the heading
Administration > Register maintenance.

2. The User selection list is used to indicate which user your calendar
changes should apply to. You can also select all. 
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3. The selection list Contents is used to select different calendar
contents, such as: working hours, time planned, time registered,
registered billable time and registered not billable time. Other
options include: the working time with the planned time (booked)
deducted, the time registered deducted or the billed time deducted.
Finally, you can display the planned time (booked) with the
registered time deducted or the billed time deducted as well as the
registered time with the working hours deducted. The contents you
select in the list will be displayed in the calendar. 

4. Select the year and month you want to display in the calendar.

5. Indicate the time format you want to use for displaying time. 

6. The working hours schedule is based either on a general or an
individual normal working hours setting (a default schedule), but this
can be adjusted by the user according to the working hours
planned. Make your changes for the day(s) concerned and click
Save. 

7. In order to insert the normal working hours registered for the user,
you click the button Insert normal working hours. This will overwrite
all the changes in the schedule with the normal working hours
indicated, i e it resets the calendar to the default schedule. See
Normal working hours below, for information on how to edit normal
working hours. Also see the heading Insert normal working hours.

Normal Working Hours
The administrator and users with extended rights can adjust the normal
working hours of all users and/or their own normal working hours. Normal
working hours is not the same thing as working hours, but are used to
facilitate the scheduling. It provides some basic information about the
expected working hours in the calendar. You can adjust the working time as
required. 

The normal working hours can be set on three levels: User, User group or All. 

1. Click the button Normal working hours, in the right-hand menu, in
order to define normal working hours.

2. Select user group and user in the selection lists if you have the right
to edit other users' normal working hours. 

3. Specify, day by day, the normal working hours of the user.

4. If you want to change the normal working hours of an entire user
group, you must check the check box Make this the normal working
hours of all user groups, below the weekly calendar. This way you
will overwrite the normal working hours for all users of the selected
user group. You will only see this check box if you have selected all,
in the user selection list.
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5. If you want to change the normal working hours of all users, you
must check the check box Make this the normal working hours of all
users. This way you will overwrite the normal working hours for all
users. You will only see this check box if you have selected all in the
selection list of user groups, and all in the user selection list.

6. If you do not mark the check boxes to overwrite the existing normal
working hours, the group level settings only affect future
registrations of new members of the user group. Changes on the
level of the organization (if you have selected all user groups) will
affect all registrations of new users, regardless the user group. 

7. Click Save normal working hours. No information in the calendar has
yet been changed, but you have defined the new normal working
hours. The calendar itself will not be affected until you insert the
normal working hours into the calendar. This is managed by clicking
the button Calendar, in the menu to the right. 

Insert Normal Working Hours
To insert normal working hours, click Administration > Calendar maintenance
> Calendar. Insert the normal working hours in the calendar, month by
month, and adjust the working time that has been registered for each date.  

1. In order to insert the normal working hours, defined earlier (see
Normal working hours above), click the button Insert normal working
hours.

2. Select user and user group for which you want to register time. 

3. Select the month concerned and the time format you want the time
to be displayed in

4. Click Insert normal working hours. The program will then convert the
data. Wait until the conversion is finished before you save. 

5. Now, you can edit separate days if you want to make changes.
Save. Each user can change his or her own working hours.

Vacancy
The page where you edit normal working hours can also be used to register
vacations for the users, i e in the menu Normal working hours. 

1. Select user and user group for which the vacation should apply. You
can register vacations for one specific user, a user group, or all.

2. Click the button New planned vacancy. The program displays a
small window where you enter a text and time Code as well as the
date of the vacation. 

3. Click Save if you want to register more vacation periods. Click Save
and close when you are finished. 
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Edit or Delete Vacancy
1. If you want to edit a planned vacation, select the user in the

selection list and click Edit. The link will only be available if there is
planned vacation registered for the user in question.

2. Edit the data.

3. Save and close.

4. If you want to delete a planned vacation immediately, click the link
Delete, and click OK in the pop-up window.

Holidays
Using this option, you can register public holidays which should be included
in the calendar and deducted from the available working hours when
resource utilization is calculated. Use the button Copy holidays to copy
information for the following year. This will copy all holidays, only changing the
year. You will then have to check the dates to a regular calendar, to make
sure that the dates are correct for the year concerned. 

1. Click the date of the holiday, which is a link.

2. Change the date or name of the holiday and click Save. 

3. Since a holiday can mean that you work half the day, you can adjust
the number of working hours for each holiday. Enter the number of
working hours for the holiday in question in the text field. Save. 

4. You can also delete the selected holiday. Click the button Delete. 

5. Click the button Back to return to the list of holidays. 

You can also register new holidays. The name of a holiday can be registered
in all languages used in the system. 

1. Click the button New holiday.

2. Set the correct date of the holiday. 

3. Enter the name of the holiday in all languages used in the system.
Click Save. All languages indicated in Organisation settings >
Languages, must be used.

Week Numbers
The menu option Week numbers is used to make settings for how you want
the week numbers to be calculated. Different countries do not use the same
rules for how many days of a new year a week must include to be regarded
as week one. The default settings are adapted to the Swedish calendar. 

1. Click the link National standards to find the method used in your
country. When you click the country link, the settings for this country
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are inserted. 

2. Click Save if you want to keep the new settings.

3. You can also change the settings on the week number page. First,
indicate the first day of the week. Then specify the minimum number
of days from the new year that a week must include to be regarded
as week one. 

4. You can also display examples on the page. By indicating a date,
you can find out what week this date will occur, with the settings
you have made. This way, you can check to see if your settings are
correct. When your settings are correct you can find out what week
a certain date will occur.

5. Make sure to save your settings.

Organisation Settings
The Organisation settings option is used to enter information on your own
organization, make settings for invoicing, and register account numbers and
result units for accounting of invoices. The administrator can register the
result units and time codes for the users. This is also where you specify which
languages you want to use in the program and how the logbook should work.

Basic Information
Enter information about your own organization. 
Organisation name

• Address, 
• Postal code
• Town
• Country
• Visiting address
• Phone
• Fax
• Mobile phone
• E-mail
• Web site
• Postal giro
• Bank giro
• Bank account
• Bank address
• VAT number

Save the information.

Settings
The administrator can make a number of settings, concerning certain
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functions in the program. Make sure to save your settings.

Choose start page for ProjectManager: 
• Show the welcome page at start. 
• Show latest project at start. 

Choose color settings:
• All users have the standard color setting.
• Users can choose their own color setting.
• Choose standard color setting.

Choose if project number or project ID should be shown when sorting by
project name:
• Project number.
• Project ID.

Choose which projects should be included in billable time. 
• Only external projects are included in billable time. 
• Both external and internal projects are included in billable time. 

Choose who can set the status of phases and activities. 
• All members of the project can change the status.
• Only the project leader can change the status. 
• Users can change the status of the phases and activities they are

responsible for.

Choose who can select a new project leader.
• Only administrators can select a new project leader. 
• A project leader can delegate his/her projects to other project leaders.

Choose the group which will form the group of directors. 
• Choose from which user groups it should be possible to choose from

when selecting responsible director for a project. 

Choose default values for new projects. Set the cost model, price model,
occurrence probability, expense rate, and how the worked hours should be
invoiced. 

Choose if each project must have a unique ID: 
• The same project ID can be used for various projects. 
• Projects must have a unique project ID.

Choose other project settings:
• It is not possible to change to which project type a project belongs.
• It is possible to change to which project type a project belongs.

Phases and activities are not affected. 

Choose if programmes should be used:
• Programmes are not to be used.
• Projects can be part of a programme.
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• A programme is a possibility to categorize the projects for a certain
customer. If a customer has several large projects that run over a long
period of time and/or have different users that should be members of
the different projects, it is instead possible to group all these projects
as a programme that consists of several smaller projects. For each
project it is stated which programme the project is part of, which
makes it easy to generate a report of the result for the projects in the
same programme. 

Choose settings for the weekly plan:
• Do not show Saturday and Sunday.
• Show Saturday and Sunday.
• Enter the number of weeks the plan shall include. If you set the value

0, no weekly plan will be shown in the menu or by the icons at the
bottom of the page. 

Invoicing
This is where you make your settings for invoicing. Make sure to save when
you are finished. 

Default Settings for Invoices
Click the link Default settings for invoicing, to select the way invoices should
be summarized. These settings will apply to all invoices, but can be adjusted
to each invoice. Adjustments are made under Reports > Invoice, when
working with the invoice in question.

Various Settings
Check the check boxes in order to:

• Display the project number together with the project title.
• Display contact persons below the project title.
• Display only the totals, not the amount and price. This means that

the columns amount and prize will not show on the invoice. Note
that if you choose Show all time registrations, the columns for
amount and prize will be shown. 

• Add product/service and time registrations (this disables the
possibility to summarize per time code and article). If this box is
checked, it means that product/service and time registrations will be
summarized per activity in the invoice details. If the box is not
checked, product/service registrations will be added to the end of
the invoice details and be summarized per article.

• Use invoice numbers that can be edited. The invoice number can
only be edited in the invoice header.

• Add a row to invoices with the expense percentage.
• Add a row to allow rounding off totals.

Settings for the Printing of Invoices
Select how you want your own company name and the customer's name to
show in relation to each other on the printed page. These settings only apply
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to the button Print, not to the PDF-file. 

• Own company name to the left, customer name and address to the
right.

• Customer name and address to the left, own company name to the
right. 

Specify the Number Series for Invoices, Details and Journals 
In the Prefix and Suffix text fields, you specify the number series to be used
for the first invoice, the invoice details and the invoice journal. Also specify the
minimum number of figures for the suffix.

The prefix is to be set out in writing and the suffix in figures.   

Terms of Payment and Delivery
Enter information on: 

• Terms of payment
• Terms of delivery 
• Value added tax (VAT)
• Method of delivery 
• Overdue interest  

Click Save when you have made your settings.

Accounting
Register the account numbers to be used for domestic sales, trade market
sales and international sales for: 

• Sales services 
• Sales material goods 
• Other sale 
• Invoice charge
• Outgoing VAT 
• Rounding off 
• Customer debts 
• Incoming VAT

Result Units
This is where you administrate the result units that should be available for
registration in the system. When handling result units, it could be that a user
belongs to a certain result unit, but also that a project belongs to a specific
result unit. The result unit of the project determines what account a project is
entered into.

Register Result Units
1. Click the button New result unit.
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2. Enter the information in the pop-up window. In the first text field,
Result unit, you enter a serial number. Then enter the name of the
result unit in all languages used in the application. 

3. Click Save and close. 

To edit the name of an existing result unit, click the serial number of the result
unit concerned. Make your changes and save.

In order to find a specific result unit, enter the name or parts of the name and
click Search. You could also click the Search button, to display a list of all
registered result units. 

Time Codes
This is where you specify the time codes to be used by the users when they
register time. Apart from the regular price, you need to have different time
codes based on different methods for setting the price and registering time
for various types of jobs and working hours. Examples could be: overtime
with different add-on percentages, extras for unsocial working hours,
sickness benefit etc. 

The existing time codes are listed when this page is displayed. The names
are links to the specific settings for each code. To the far right, you can view
the price calculation method used for the time code when invoicing. 

New Time Code
1. Click the button New time code.

2. Specify if the time code should be billable to the customer. 

3. Specify if the time code should be included in the salary details.
Decide if you want the total of the registered time for the period, or
every registration made, shown in the details. The advantage of
showing all registrations can be when for example a time code for
parental leave is used and the dates for each registration is needed.  

4. Indicate a salary type which the time code should be linked to, in
order to work with your system.

5. Enter the name of the time code in all languages used in the
application. 

6. You need to specify the add-on as a percentage or as a constant
amount. This is used for calculating the price with this time code
when preparing invoices. If you are not using any add-on, you
should enter a 0 in the field. When you have indicated your
numbers, the price is calculated automatically based on the settings
you have made. 

7. Click Save when you are done, and click Back to return to the page
with the list of time codes. You can also click Search to get back to
the list. 
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Fix Sorting Order
When you are using many different time codes, the order in which they are
displayed becomes important. The time code which is most frequently used
should be the default choice, and other common codes should be at the top
of the list. In this way, the user can easily make the daily time registrations.
The settings are done by sorting the order of the codes. 

1. Enter a number for each time code under the heading Sorting order.
Number 1 will be displayed at the top of the selection list for the
time registration etc.

2. When you are done with your settings, click Save.

Registration
You make settings for the time registration here.

Specify the minimum amount of minutes available for time registrations in the
radio buttons. 

Note! If you use the time keeper and would like to save a registration of 10
minutes, when 20 minutes has been specified as the minimum amount of
minutes available, 20 minutes will be saved instead.

Set the limits for time registration.
If you want it to be limits for how large each time registration can be, or how
many hours a user can register per day, enter the valid intervals here. If you
do not enter anything, the time is unlimited. 

State if the comment field should be a compulsory field or not.

Choose the sorting order for phases and activities: 
Choose if the phases and activities should be shown in alphabetical order or
in the order set by the project leader. 

Choose which activities can be registered: 
Choose if it should be possible to make registrations on all phases/ activities
in an active project or only to register time on active phases and activities. 

Choose if you want it to be possible for the project leader to state a lock date
for the projects. This means that the project is locked for new, edited and
deleted time registrations earlier than the lock date. It will still be possible to
register time on the project after the lock date. 

Choose the rights for the users who are allowed to register time and
products/services for other users.
Choose if you want the user with the right to register time and
products/services for others, should have the right to register for all users, or
only users in his/her own user group. 
Note that the administrator always can make registrations for other users. 

Select if it should be possible to register estimated time left. Select if it should
be possible for users in Registration/week to state how much time they think
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is left on the project/phase/activity. From an icon at the bottom of the page it
is also possible to generate a report of this. 

Verification
Here, you specify how registered time and products/services should be
verified. The verifications are made in the Registration part of the program. To
get there, click the Registration icon at the bottom left of the page. Then go
to the menu Verification, at the top of the page.

The administrator can verify time and products/services for all projects. 

Project leaders and users need to have the right to verify time and/or
products/services, in order to do so. For more information on rights, see the
heading User rights.

1. If you want time and products/services to be verified before it is
invoiced, you mark the check box Registrations must be verified
before they can be shown on salary reports and invoice details. If
you do not mark this check box, all registrations will be displayed in
the salary and invoice details.

2. Mark who should have the right to verify: the project leader or the
user.

The project leader can verify all registrations of his/her projects. The
restrictions, if any, on a user's rights to verify, have to be specified.   

Specify if the user should be allowed to:

• Verify all users.
• Verify chosen users (only one verifier per user allowed).
• Verify chosen users (multiple verifiers per user allowed).
• Verify users belonging to the same result unit as the verifier.
• Verify users belonging to the same user group as the verifier. 

Check the box Verifiers cannot verify their own registrations, if you do not
want the verifiers being able to verify their own registrations. 

Save when you have made your settings.

User Rights
The settings you make will form the basis for the registration of new project
leaders and members. The administrator always has all the rights.

At the bottom of the page, there is a check box: Reset the rights of all
existing users to these default rights. If you mark this check box, all existing
rights will be set according to the rights marked. Each user can then be given
individual rights.

In the column to the far left, you set the project leader's rights and in the next
column you set the project members' rights.
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These are the rights you can set:

Register Maintenance
• View the information of other users. 
• Edit the information of other users.
• Edit the rights of other users. 
• View customer information. 
• Edit customer information. 
• View supplier information. 
• Edit supplier information. 
• View product/service information.
• Edit product/service information.
• Edit project types, phases and activities. 

Calendar Maintenance
• Insert normal working hours into calendar. 
• Edit own working hours. 
• Edit all users' working hours. 
• Edit own normal working hours. 
• Edit all users' normal working hours. 

Registration
• Register time and products/services for other users. 
• Verify time registrations.
• Verify registrations of products/services. 

Invoicing
• Edit own invoice details.
• Edit all invoice details. 
• Edit own invoices. 
• Edit all invoices.
• Edit invoice journals. 

Reports
• Create public reports.
• See all users' registrations.
• See projects the user is not a member of.
• See own salary details. 
• See all users' salary details.
• See control information.  

You have the possibility to from here set back all existing users' rights to the
default value. To do so, check the box Reset the rights of all existing users to
these default rights, and save. 
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Languages
This is where you indicate which languages should be available in the
application, as well as which language should be the first choice. 

In some contexts, the languages activated will have to be used, e g for
projects, phases, activities, result units etc.

• Activate the languages by marking the check box next to the
language in question.

• Mark the radio button in front of the language preferred as your first
choice.

Logbook
The logbook records any error messages that occur. If an error message is
listed in the logbook, you should contact the help desk at
www.artologik.com, or use the e-mail form on the page to send an error
message to our support account helpdesk@artologik.com. 

Note! The logbook should not be emptied, unless you obtain the go-ahead
from the Artologik help desk. 

Database Report
Under Administration > Organisation settings > Logbook, there is a function
to create a database report. This report continually corrects registered
information and fills in any missing information. 

The function searches the whole database for logical mistakes, in order to
detect invalid registrations, such as: time registrations for non-existing users,
products/services not available, or registrations made for an invalid supplier.

You can generate a statistical report of the content of the database. The
report includes the following:

• Table name
• Description 
• The number of entries
• Alterations – errors attended to 

Bear in mind that this process might take a very long time to generate and, as
a consequence, make it difficult for other users to access the system.
Therefore, it should be run at a time when as few users as possible are
connected to the system.

1. Click the button Database report in order to search the entries in the
database. The tables of data are now searched. If any mistakes are
found, it is corrected and the search is interrupted.  

2. Invalid entries not necessary are removed automatically. However,
some pieces of information are needed for a project to be registered
correctly. Therefore, these pieces of information have to be entered
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via the database. If it is not evident which value an entry should get,
it is listed on the page and possible alternatives are displayed in a
selection list. Select the real value and click save for each
correction. The number of corrected entries is listed under these
manual adjustments. If any automatic adjustment is made, it is
displayed at the bottom right under the heading Change. If it says -1
it means a removed entry and +1 that an entry has been added.   

3. When you have corrected these invalid entries, the database search
can continue. The search starts from the beginning, since your
corrections can change other results that should be checked again.

4. Make your corrections, if any, and click the database report as long
as the text in the field under the database report says: Correct the
following and generate a new report. On the contrary, when the text
says: The report is finished, no mistakes found in database, the
search is finished.

5. Save.
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Manual and Licence Information
To access the manual from the program, click the link you want the manual
for. To open the file you need Adobe Reader. If you do not have Adobe
Reader, you can download it for free by clicking the linked image. Print the
manual by clicking the print symbol in the tool bar. You can also download
the manual by clicking the disk symbol in the tool bar and saving it on your
computer to read and/or print it later on. 

If your organisation uses more than one Artologik® product, the Artologik®
logo in the top right corner can function as a link to the login page for the
other products. 

You can also see the add-on functions that are active for you. If you have one
or more of those add-on functions, you will find separate manuals for them.

For more information about ProjectManager and to see what material you can
download, visit www.artologik.com.
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Step by Step
Since it is the administrator who, initially, handles the application and enters
most of the information, this section is intended for persons with this role. 

Login Routines
Administrators can choose between different methods for giving the user
access to the login function of the Artologik products. There are three
alternative ways of handling the login procedure. You control this by making
settings for the web server. 

Standard Login
When you install an Artologik program on a web server, the set-up program
sets up a standard login procedure. This procedure is based on the
assumption that the web server settings allow anonymous access. This
would mean that the normal login procedure and user identification of
Artologik is used. The Artologik user always gets a personal user name and
password which are registered by the administrator. When you log in, a
unique and secret ID is created. This ID is used for as long as you are logged
in. Every time you do something in the program, access is ensured through
this secret ID. 

Standard Login Without a Product List
If you have installed an Artologik program, you do not need the page where
you select a program after the login. Follow these instructions to skip the
product list after the login:

Open the file <installationpath>\Artologik\wwwroot\default.htm where
installationpath is the catalogue where you chose to install your Artologik
product. Change AGS_Login.exe to
AGS_Login.exe?LaunchApp=<PRODUCT> where <PRODUCT> is replaced
with the product code in question, either: EMR, EZ, HD, PM, QR, TIME or
PUB, depending on which program you wish for to open automatically. 

Note that the program is sensitive to upper and lower case letters and that
the brackets should not be included in the path or in the product code in
question.
 
Use any of the following product codes:

Program Application Code

EZbooking EZ

TIME TIME

ProjectManager PM

EmailResponse EMR

HelpDesk HD
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Query&Report QR

WebPublish PUB

Login With Identification Through Network Login
ID
The Artologik programs may be installed in a network where anonymous
access is not allowed and the user must log in with his/her user name and
password to gain access. In this case, Artologik will take the user name and
try to match it to Artologik’s list of registered user names. If this user name
has not been registered, you end up at the normal login field, where you can
login using the personal user name and password for this Artologik product.
In this way, you will be able to raise security by having the login in two stages
with different user names, one for the network and one for Artologik. Having
the same user name for Artologik as for the network, is one way of making
the procedure easier, since you are then only required to log in once. Also in
this case, the administrator registers the user name and password. This
routine requires Microsoft internet information server version 4, and that you
have enabled server access with network identification. 

Direct Access to the Programs
If you want to use the Artologik programs as an integrated part of your web
site, you can create direct links to the programs by using the following
formula for linking: http://www.domain.nu/artologik-mapp/cgi-bin/
AGS_Login.exe?LaunchApp=applicationcode 

Replace the word applicationcode with one of the following application
codes, which should be inserted into the link above: 

Program Application Code

EZbooking EZ

TIME TIME

ProjectManager PM

EmailResponse EMR

HelpDesk HD

Query&Report QR

WebPublish PUB

When you create direct links, you have to log in the first time you are going to
enter the program. The web browser will then keep your login ID, until you
have closed the program down completely. This means that you do not have
to log in more than once per session. If you use network identification, you
will be able to go straight into the program without having to log in. 

Step-by-Step
The following section is a step-by-step description of how you enter

© Artisan Global Software 



Manual | 85

information in ProjectManager. Since it is the administrator who, initially,
handles the application and enters most of the information, this section is
intended for persons who have this role. All the information is registered
under Administration in the menu bar at the top of the page. 

Step 1
The first thing you should do, is to register your Organisation settings. Click
Administration in the menu bar at the top of the page. You will find
Organisation settings at the bottom of the right-hand menu. 

1. Click Basic information and register information on your own
organisation. Click Save. 

2. Move on to Settings and mark the settings you want to use and
save.

3. Go to the Invoicing option in the right-hand menu and set the
properties for invoicing. Take great care when registering prefix and
suffix. This information can not be changed at a later stage! Register
the other information on the page. Click Save.

4. Click Accounting in the right-hand menu and register the account
numbers to be used when accounting invoices. Click Save. 

5. Register Result units, which forms the base for e g accounting
invoices. Click Add result unit. Enter the information in the pop-up
window and then click Close. 

6. Click Time codes and register time codes as described in the
manual.

7. Move on to Registration and select how you want the registrations
to be made. Make sure to Save.

8. Under the heading Verification, select how verifications should be
made. Click Save.

9. Under the heading User rights, set the levels of rights which form
the base for the registration of project leaders and members. Click
Save.

10. Go to Languages to specify what languages should be used in the
program and which language will be the first choice. Click Save.

Step 2

User Groups
Next, you need to register user groups and specify the normal working hours
of these groups. Dividing the staff into different groups is a way of getting a
better survey of the resources and skills available within your organization.
When the project leader is planning the project, he/she will then be able to
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study the resource utilization within the different user groups, and where the
available resources are within the user group.

1. Click Administration > Register maintenance > User groups.

2. Using the button New user group, a form opens where you enter
the name of the user group in the languages you have decided to
use in the program. 

3. Save and repeat the procedure until you have registered all the user
groups you want to divide the staff into. 

Normal Working Hours
To make calculation of the resource utilization possible, there must be
information on the working hours in the personal calendars of all users. To
simplify the task of entering this information, indicate the normal working
hours of the different user groups. These working hours will then be used for
all users that you register in the system and in the user group in question.
This way it can be regarded as the default working hours, which could, of
course, be edited by the user later on.

1. Go to the Administration > Calendar maintenance > Normal working
hours.

2. Use the selection lists, at the top of the page, to select the user(s)
for which the normal working hours should apply. 

3. Specify what the normal hours of the selected user(s) should be. 

4. If you want to replace the existing normal working hours, you must
select a box below the weekly calendar. The boxes are there as a
precaution, so that you do not accidentally replace the registered
working hours. 

5. Click Save normal working hours.

6. Click the button Calendar and select Working hours in the first
selection list to display the working hours. Select user group and
user. You can also select all in these two lists. 

7. Select year and month where the normal working hours should be
inserted. 

8. Click Insert normal working hours and save, to apply the registered
normal working hours to the user(s) for the month concerned. If
there are any users registered already, their total time will be
displayed in the calendar.

9. Repeat steps 7-9 for all users/user groups that you want to register
different working hours for.
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Other Calendar Settings 
Using the menu option Holidays, you register public holidays and copy the
holidays to the following year. When this has been done, you must check the
dates and change them so that they are correct for the year concerned. You
can register more holidays later on. For more information, see the part To be
an Administrator > Calendar maintenance, in this manual. 

The menu option Week numbers is used to make settings for how you want
the week numbers to be calculated. Different countries use different rules for
how many days of the new year a week must include, to be regarded as
week one. 

1. Click the link National standards to find the method used in your
country. When you click the country link, the settings for this country
are inserted. 

2. Click Save if you want to keep the new settings. 

Step 3
The next step is to register users. This menu option is available in the right-
hand menu under Administration > Register maintenance. 

1. Click the button New user. 

2. Enter information on the user. You must enter information in fields
marked with a star.

3. Indicate language, user role, user group, and result unit for the user.
 

4. Specify a cost per hour and a price per hour, to be used when
invoicing the time worked by the user. 

5. Specify the sorting order of projects by selecting one of the
alternatives in the selection list.

6. Select the format for the time registration.

7. Select the time format to be used for displaying the time registered.
You can use hours with two decimals: hh.hh e g 2.75, or hours and
minutes: hh:mm e g 2:45. 

8. Click Save. 

Step 4
It is now time to register customers. Click Customers in the right-hand menu. 

1. Click the button New customer at the top of the page.

2. Enter information on the customer. You must enter information in
fields marked with a star. 
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3. Click Save.

4. You can register contact persons for the customer by clicking New
contact person. 

5. Click Save.

Step 5
It is time to register suppliers. 

1. Click Suppliers in the right-hand menu.

2. Click the button New supplier in the the right-hand menu.

3. Enter information on the supplier. You must enter information in
fields marked with a star.

4. Click Save.

5. You can add contact persons for the supplier by clicking New
contact person.

6. Click Save.

Step 6
Now, it is time to register products and services.

1. Click Products/Services in the right-hand menu.

2. Click the button New product/service at the top of the page.

3. Enter the information. You must enter information in fields marked
with a star.

4. Click Save.

Step 7
The seventh step is to register phases and activities. Click this option in the
right-hand menu. 

1. Click the button New phase. 

2. Enter a name for the new phase. You can also enter a description. 

3. Click Save.

A new page is displayed where you can add new activities which are linked to
the phase. You can also delete the phase and name/describe the phase in
the other languages available in the system. 

1. Click Add activity. Enter the name and a description of the new
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activity.

2. Click Add or Add and close.

3. To delete a phase, click Delete phase. Click OK in the pop-up
window, if you want to delete the phase, if not, click Cancel. Please
note that any activities linked to the phase will also be deleted. 

4. By clicking Other languages, you can enter or update the names
and descriptions in all the languages available in the system. 

5. Click Save.

Step 8
1. The next step is to register project types. Click Project types in the

right-hand menu. 

2. Click the button New project type.

3. Enter a name of the project type. You can also enter a description of
the project type. 

4. Click Save. 

5. A new page will be displayed, where you can link phases and
activities to the project type. Click Add phases and select the phase
you want to include. 

6. Click Add and then Save.

Step 9
The final step required before you can start using ProjectManager, is to
register projects. This is done using the Project administration option in the
main menu. 

1. Select New project in the selection list under Projects.

2. You must enter information in the fields marked with a star: Project
name, Project type, Start date and End date. Try to enter as much
information as possible. This will make it easier to work with the
projects. 

3. Click Save.

When you have worked your way through these steps and registered the
information described above, you are ready to start using Artologik
ProjectManager. In the menu bar at the top of the page, under Projects and
Project administration, you can select Customer and project, or make a
search using the Project number to find the project you want to work with.
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